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FOREWORD

Customs Clearing Agents, Freight forwarders, and Warehouse Operators in the East African Community
(EAC) region continue to play a vital role in the facilitation of trade particularly with regards to the assessment
tax, storage of goods, transportation, and last-mile delivery to clients. This, in turn, facilitates cargo movement
and clearance from all ports.

The agents handle goods worth millions of dollars on behalf of the shippers. Besides, they originate documents
that facilitate movement and clearance of cargo culminating in errors that slow down the flow of business. The
movement of cargo depends on how fast and correctly documentation is done for verification by the respective
Customs Authorities. A delay in customs clearance increases the cost of doing business.

This pointed to the need for these agents to be equipped with the requisite knowledge, skills, and attitudes to
carry out their work efficiently, just as their counterparts from customs.

The EAC region, with support from TradeMark East Africa (TMEA), has made significant steps towards bridging
the knowledge and skills gap in the customs clearing and freight forwarding industry. The introduction of the
East Africa Customs and Freight Forwarding Practicing Certificate (EACFFPC) in 2006, a regional training
programme jointly implemented by the EAC directorate of customs, the East African Revenue Authorities
(EARAEs), the National Association of the Freight Forwarding Industry, and FEAFFA was a big step. Since its
inception, over 7000 agents have graduated from this training.

A review of the programme in 2015 and a market survey conducted in 2020 supported by TradeMark East
Africa (TMEA) highlighted key areas of improvement for the EACFFPC programme to achieve the aim of
producing competent customs agents, freight forwarders, and warehouse keepers. The revised curriculum has
therefore been designed to address these challenges and shortcomings. The revamped EACPPFC programme
is designed to enhance the ability of freight forwarders to provide competitive and high-quality end-to-end
services thereby reducing inventory costs and increasing safety levels in warehousing operations in the East
African region.

With the revised EACFFPC curriculum, the dream of attaining a professional and compliant freight logistics
industry in the East African region has been strongly boasted.

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE n
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1.0 UNIT OVERVIEW
1.4 Unit Description

This unit describes competencies required to
use a computer and other digital devices for the
purposes of communication, work performance
and management at the workplace. It addresses
different computer software and hardware required,
data security in an automated environment, using
computers to solve tasks, communicate and store
information.

1.2 Unit Summary Learning Outcomes

At the end of the unit, the trainee should be able to:

1. Identify computer software and hardware

2. Apply security measures to data, hardware,
software in automated environment

3. Apply computer software in solving tasks

4. Apply internet and email in
communication at workplace

5. Apply desktop publishing in official
assignments

6. Prepare presentation packages

2.0 INTRODUCTION TO ICT AND WINDOWS
OPERATING SYSTEM

2.1 Specific Learning Outcomes

At the end of the topic, the trainee should be able to:
i. Explain the Concepts of ICT and the
Components of a computer
ii. Explain the Functions of ICT
iii. Identify the role of Windows Operating

System in  conducting  business
operations

iv. Navigate the computer using Windows
Operating System

v. Create and manipulate files and folders
2.2  Introduction

For Windows Operating System, the model
introduces students to the concept of operating
systems with a view of appreciating its role within
the computer. The topic covers the role of windows
in the computer; common locations in the windows
operating system; creating and manipulating files
and folders. The unit module should emphasize the
parts of a windows, concept of paths, file explorer,

creating and manipulating text files, and using basic
windows commands.

2.3  Concepts of Computing

2.3.1 Definition of a Computer

o A programmable, electronic device that
accepts data, performs operations on that
data, and stores the data or results as needed.

o Computers follow instructions, called
programs, which determine the tasks the
computer will perform.

o Too many people and organizations
purchase and use Computers for the wrong
reasons. Computers are practical tools to be
used in helping you get results.

2.3.2 Benefits of using a Computer

Computers are needed where:

o We need accurate knowledge to assist
decision making.

o There are time constraints or sheer
magnitude of work involved.

o  We need to reduce effort in tackling
certain tasks.

« Weneed cost efficiency.

o There is a need to assist in enhancing
Customer service.

« There is a Decisions making
process such as forecasting of market
trends to ensure business survival.

2.3.3 Functions of a Computer

o Input: Entering data into the computer

o Processing: Performing
operations on the data

o Output: Presenting the results (information)

o Storage: Saving data, programs, or output
for future use

o Communications:
data

Sending or receiving

ﬂ THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE
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2.4 History of Computers

o “Computer” was originally a job title:

it was
beings

used to describe those human
(predominantly women) whose

job was to perform the repetitive
calculations required to compute such
things as navigational tables, tide charts,
and planetary positions for astronomical
almanacs.

o Before computers, we had early computing

devices
o

Abacus, slide rule, mechanical
calculator.
Punch Card Tabulating Machine

and Sorter.

Evolution of Computers:
First-generation computers (1946-1957)

(0]

Enormous and powered by
vacuum tubes for circuitry
and magnetic drums for
memory,

Were enormous, taking up entire
rooms.

Input was based on punched
cards and paper tape.

Used a great deal of electricity, and
generated a lot of heat

ENIAC and UNIVAC

« Second-generation computers (1958-1963)

o

A Transistor

Used transistors instead of vacuum
tubes

Computers were smaller, more
powerful, cheaper, more energy-
efficient, and more reliable

Punch cards still used for input,
however magnetic drums were
replaced by magnetic tape to input
and store data.

IBM Stretch computer of 1959

« Third-generation computers (1964-1970)

O
O

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE

Used integrated circuits (ICs).
Transistors were miniaturized and
placed on silicon chips, called
semiconductors.

Increased the speed and efficiency
of computers.

Keyboards and monitors
introduced to replace punched
cards.

The use of an operating
system, which allowed the
device to run many different
applications at one time.
Computers became accessible to a
mass audience because they were
smaller and cheaper than their
predecessors.




DIGITAL LITERACY

« Fourth-generation computers
(1971-present)

O

Use microprocessors. Thousands of
integrated circuits were built onto @
single silicon chip. Theresult
was the microprocessor.

A computer could now fit in the
palm of the hand.

Use keyboards, mice, monitors,
and printers.

Use magnetic disks, flash memory,
and optical disks for storage.
Computer  networks,  wireless
technologies, Internet introduced.
The Intel 4004 chip, developed in
1971, located all the components
of the computer - from the central
processing unit and memory to
input/output controls - on a single
chip. In 1981 IBM introduced its
first computer for thehome user (the
personal computer), and in 1984
Apple introduced the Macintosh.
Microprocessors also moved out
of the realm of desktop computers
and into many areas of life as more
and more everyday products began
to use microprocessors.

o  Fifth generation (now and the future)

O

Infancy stage based on artificial
intelligence

Are still in development,
though there are some applications,
such as voice recognition, that are
being used today.

The goal of fifth-generation
computingis to develop devices that
respond to natural language
input and are capable of
learning and self-organization.
Based on optical computers and
utilize nanotechnology

2.5

Technology of Tomorrow

O

O

Nanoscience - study of very small
structures

Biomedical Chip Implants -
embedded as identification devices
Artificial Intelligence - make
decisions based on criteria
Autonomic computing -
manipulation of computers

Self

Components of a Computer

A computer may be classified by technology
(Digital/Analog), purpose (General/

Specialized),

and size. We focus on

classification by size.

Mini-Computers

(Laptops,

Notepad, PDAs, Mobile Phones,

& embedded

computer) -

combines the CPU, the monitor, the
keyboard, and the mouse in one unit.
o

So small that you can carry it
on your laps when commuting.

Includes laptops, notebooks, PDAs
etc.

Other parts can be connected to the
laptop.

Can do anything that a desktop can
do except for embedded devices.

Embedded computers are

embedded into a product and

0 designed to perform
specific tasks or functions
for that product

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE
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« Micro-Computer (Desktop) -
can be positioned on top of a table where a
person is working.

« Macro-Computer (Main frame)
Mainframe computer: Powerful computer
used by large organizations to process large
amounts of centralized data

o Standard  choice for large
organizations, hospitals,
universities, large  businesses,
banks, government offices.

o Located in climate-controlled data
centers and connected to the rest
of the company computers via a
network.

o Larger, more expensive, and more
powerful than midrange servers.

o Usually operate 24 hours a day.

o Also called high-end servers or
enterprise-class servers.

. Macro-Computer (Server) -
Holds information that other computers,
can retrieve.

o The computers are connected
to the server via cable, wireless
connection, etc to be able to retrieve
this information.

o Although not particularly
recommended, any computer,
including a desktop or even a laptop
can be used as a server, as long as it
can do the job required.

o A server is more defined by the
program (called an Operating
System) that is installed in it, not
how the machine looks.

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE

« Macro-Computer
(Supercomputers) - are built to
minimize distance between circuit boards.

o They operate at very high speed
for complex uses such as designing
airplanes, solving  complex
engineering  formulas  having
billions of steps mathematically etc.

o Supercomputers are the main
servers in the Internet System.

2.6 Computer Hardware

o Refers to the Physical parts of a
computer

o Hardware is made up of devices classified
as:
o Input Devices
o Storage Devices
o Processing Devices
o Output Devices

| Input Device | CPU

¥
h 4

Data Intarmation
__>‘ Marmory I—

| dutput Deuzccl

A

o Input Devices: Accept data or instructions
from the user. Data is the raw facts that are
fed to the computer.

o Keyboard: An input device used to
enter characters at the location marked
by the insertion point or cursor. It can
be wired or wireless.

o Pointing devices: Used to select
and manipulate objects. Often used to
select input data or issue commands
to the computer. Common types of
pointing devices are the mouse, Stylus,
and Touch screens.

o Scanners, Readers, and Digital
Cameras - access input from source
documents containing data that
already exists in physical form (order
form, photograph, invoice, check, or
price label)
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Output Devices: Used to provide feedback
from the computer. They can produce soft
copy or hard copy output.

o Monitors & Display screen:
Presents output visually. Monitors are
detached devices such as those used
for a desktop computer while Display
screens are inbuilt into a variety of
devices such as tablets. They produce
soft copy output.

o Data projector: Display device that
projects all computer output to a wall or
projection screen. Often, they are found
in classrooms or conference rooms.
They can be wireless or integrated into
devices. They produce soft copy output.

o Printers: Produce hard copy output.
The most common types of printers
are inkjet printers and laser printers.
There are other printers that are also
becoming common such as LCD, LED,
Thermal and 3-D printers,

Processing Devices — Also known as the

Central processing unit (CPU) or processor/

microprocessor. It does the vast majority of

processing for a computer. Processing refers
to the conversion of data to information.

Information is the output that is useful for

decision making. There are two processing

devices that make up the central processing

Unit.

o The Arithmetic Logic Unit - This
is the part that executes the computer’s
commands.

o The Control Unit -The control unit
is the part of the computer fetches
commands for execution. It takes
several fetch and execution cycles to do
even a simple addition of two numbers.

Storage Devices — Keep information for
future retrieval or consumption. Consist of
a storage device and a storage medium. A
Medium is inserted into device to be used.
Storage devices are typically identified by
letter C:

Data can be stored randomly or sequentially
The data retention ability of a device
determines its volatility. Volatile - Storage
that lasts only while the power is on
for example with RAM, CACHE, and
REGISTERS. Non-Volatile - Storage that
lasts regardless of the power availability
such as Hard disks or ROM.

Main Memory - (Internal) refers to chip-
based storage needed by the computer
when it is working. RAM (random
access memory) is the computer’s main
memory and can be expanded. ROM (read
only memory) are chips located on the
motherboard into which data or programs
have been permanently stored.

Secondary Storage - (External) refers to
storage devices that keep data for future use.
It can be:
1. Magnetic Storage - Store data using
magnetic fields e.g. Hard disk, Magnetic
tape.
2. Optical Discs - Store data optically
(using laser beams) e.g. CD, DVD, or Blu-
Ray Disc (BD).
3. Flash/Electric Memory Systems — Store
data using electric charge e.g. Solid-state
storage disks or Flash memory sticks/
cards.

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE
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o System unit. The main case of a computer.
Holds the internal hardware for a
computer such as the Main Circuit board
(Motherboard), Storage devices, Power
supply, Cooling fans, CPU, Memory,
Expansion Cards, and other components.

CPU POWER SUPPLY FAN HARD DRIVE
Performe the calculations Corverts standard Cools the CPL. ‘Stores data and programs;
and does the compansons electrical power into the principal storage device

needed for processing, az a form the computer for most computers.

EXPANSION CARD well as controls the other use.

Connects peripheral parts of the computer DRIVE BAYS

devices or adds new system. HI:IN:. storage

capabilities to a devices, such as

computer. the II\I'I} and
hard drives
shown here.

EXPANSION SLOTS

Connect expansion

cards to the mother- DVD DRIVE

board to add addi- Accessss data

tional capabilities. stored on Chs
or DVDe.

MOTHERBOARD

Connects all compo- ——— FLASH MEMORY

nents of the computer CARD READER
system; the computer's Accesses data
main circuit board. :l:;r':n: on flash
MEMORY (RAM) MODULES — v ’
Store data temporarnily while
you are working with it. {'-E“B PORTS
MEMORY SLOTS nect USB
Connect memory devices to the
modules to the computer.

FIGURE 2-7

Inside a typical

sy stem unit. The
systam unit houses
the CPU, mamary, and
other important pisces
of hardwara.
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« Ports and connectors

FIGURE 2-18
Typical ports for
doskiop compulars
and examplos

of connectors.

mWEH&WNNEmH EIEHEWHEHMHT
nects the nnects FireWire
computer to a power devicsa, CONMECTORS
outlet. I r Manitor (VGA)
VGA MONITOR PORT =
Connects a VGA L use
monitor, \ _— METWORK PORT
e Connects the computer
1oa netwark.

USE PORTS ; Maniter (HDMI)

—_—
Connect a keyboard, r
maouse, scanner, flash AUDIO PORTS
memory drive, printer, Connect speakers,
digital camera, or other headphones, and a FireWirs

USE devices,

icraphone, a
EMPTY 5LOTS P

Ports located on new

Metwaork {(R1-45)

HDMI PORT expansion cards added -
Connects a high-definition to the computer will be i Audie (3. Gmm)
maonitor, aceessible here, -

2.7  Computer Software
« Non-Physical parts of a computer.
Refer to instructions given to a
computer.

o Software Categories

CATEGORIES OF SOFTWARE

e - APPLICATION
SYSTEM SOFTWARE SOFTWARE

S Programs that allow you to
OPERATING perform specific tasks on a
SYSTEM computer

The operating system and utility
programs that control how a
computer works and allow you to LW ﬂ
:JSE your computer ndows
Syeiems

ﬂ THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE



System Software - Starts and runs the
computer. It finds devices and launches
applications. It manages files (storage) and
Controls hardware configuration. It also
protects the computer from unauthorized
use and maintains it by providing Backup
and recovery tools.

Application Software - Performs a
user’s tasks such as creating documents and
playing some music. Common examples
include word processors, spreadsheets,
databases, presentations, and graphic
applications.

The computer startup process is also

known as the Boot Process and includes the

following steps:

o Step 1: The basic input/output system
(BIOS) is activated.

o Step 2: A Power-on-self-test (POST)
checks attached hardware.

o Step 3: The operating system loads into
memory.

o Step4: Configuration and customization
settings are checked.

The  operating  System  facilitates

communication with the computer

hardware. Common operating systems are

Microsoft Windows, Apple macOS, Linux,

Android and iOS. All operating systems

must handle three basic tasks:

o Allocating System Resources
- The operating system decides what
resource will be used and for how long.

o Monitoring System Activities
— These activities include System
Performance and System security

o File and Disk Management -
A user needs to copy, move, delete,
and rename files. This is the category
of operating system functions that
the user actually sees the most. (File
management).

Utility programs - Software that performs

a specific task, related to managing or

maintaining the computer system. Many

utilities are built into operating systems.

Examples include Disk clean-up utilities,

Accessibility Utilities, and Display Utilities.

2.8
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Windows Operating System

2.8.1 Working with files

A key task of the operating system is
working with files and folders. When
working with the computer you will need
to do this almost all the time. Here we look
at the basics of working with files, including
how to open files, move your files into
folders, and delete files.

Files contain your work and can include
written documents, digital photos or videos
are all types of files. When working with
the computer you will be viewing, creating,
or editing these files.

Files are usually represented by an icon
with a name. In the image below, you can
see three different types of files with icons
representing the file format. We shall
examine more on these formats later.

MIST PROJECT REVIEWERS FFEDBACK
Mnderatinn Report
[ﬂ S5T -certificate_correction_ for Masters

2.8.2 Working with folders

Evidence

Results

Windows uses folders to help you
organize files. You can put several related
files inside a folder, just like you would put
documents inside a real paper folder. In the
image below, you can see some folders.

Mine
SPRING 2015_FINAL

2.8.3 File Explorer
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You can view and organize files and folders
using a built-in application known as File
Explorer.

To open File Explorer, click the File
Explorer icon on the taskbar, or double-
click any folder on your desktop. A new File
Explorer window will appear. Now you're



DIGITAL LITERACY

ready to start working with your files and
folders.

) ) Open
» Notice that you can also see the location of _
a folder in the address bar near the top of |@ Recent.
the window. 25 shared with Me
OneDrive
| = | Test -
Other locations
Home Share Wiew = .
[ misec
« v 1 » This PC > Documents > Test é— @ R—
[] Name - = Browse
s Quick access
I Desktop » images
¥ Downloads 4 my work
ownloa n . . .
A app « Moving and deleting files - As you begin
Documents » [&] Capture X .
, P using your computer, you will come across
[&] Pictures b4 D cnnoxps /
Class Notes & Glare scenarios where you need to move files to
Digital Literacy image research different folders or delete files you no longer
Google African Aca Lab Exercise - Advanced MS Word use.
Updated gmyw‘"" « To move a file: Click and drag the file to
olp . .
@ OneDrive ] Sample_Output the desired location. Release the mouse.
B test The file will appear in the new location. In
the following example, we drag the word
* Network .
document to the recipes folder.

= ~ 4 ¥ » ThisPC » Documents > v D A Sean
~
2.8.4 open afile » o Quick access B M=
> @ OneDrive Is=
i
: W This PC == =%
« There are two main ways to open a file: i : .
) ) > 930 Objects Photos Recipes k[-‘_‘n—
« Find the file on your computer using file o
> [ Desktop

explorer or otherwise and double-click YL i N
it. This will open the file in its default T — ‘ III
application. In our example, we'll open a > b Music l

Microsoft Word document (Cover Letter. . Budget "
docx), which will open in Microsoft Word. ' '

« You can use this same technique to move

I e -0 folders. Note that moving a folder will also
 v=1B e — " P | B ———— B move all the files within that folder.
# Quick access . = S AN
:W b ’%J kd v% 2.8.5 Create a new folder
8 This PC g >~ o~
Y o - - e « Move to the location where you need
C— II the New folder then select the New Folder
g 5II s icon shown below or right-click, then
B oot — select New Folder. The new folder will
Beinase BIN. - appear. Type the desired name for the folder
and press Enter. In the following example
o Open the application, then wuse the we called it School Documents.

application to open the file. Once the
application is open, you can go to
the File menu at the top of the window and
select Open. We shall examine this option
more later.
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v

£| ¥ | = | Documents = O X
“ Home Share View v o
€ = v 4 %> This.. > Docum... » v | D £ Search Documents
A
o Quick access B
@ OneDrive !% §] !"‘% E‘ II
= This PC ~I F I~ e
3D Objects Recipes Work Budget
I Desktop S
s Documents W
& Downloads l
b Music
B Pictures Cover Letter School é
DocumeaniT
. Videos -
£ Local Disk (C) v
2.8.6 Rename a file or folder 2.8.7 Delete afile or folder
e You can change the name of any file or « If you no longer need to use a file or folder,
folder. A unique name will make it easier you can delete it. When you delete a file,
to remember what type of information is it is temporarily moved to a folder known
saved in the file or folder. as the Recycle Bin. If you change
o Right-click on the folder and your mind, you can move the file from the
select Rename from the menu that appears. Recycle Bin back to its original location. If
Replace the old name with the desired name you're sure you want to permanently delete
on your keyboard and press Enter. The the file, you will need to empty the
name will be changed. Recycle Bin.
Give access to
v | Documents Restore previous versions
Home Share View i
« = v 4 = » This.. » Docum.. » v | ® 4 o
A Name B Copy
# Quick access
L Photos Create shortcut
@ OneDrive Recipes Delete
& This PC School Documents Rename %
-~ Work ;
bj } Properties
WLEP-Objs il Groceries_Budget_March ACSATTE
— Heakicp ﬁ;] Cover Letter Microsoft Word Document
s Documents
¥ Downloads
D Music
= Pictures
& videos
2. Local Disk (C) v €
6items 1 item selected 8.06 KB
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Right-click on the folder and
select Delete from the menu that appears.
You can also click the file to select it and
press the Delete key on your keyboard.
Note that deleting a folder will also delete all
the files within that folder.

Selecting multiple files

This technique helps you to manipulate files
and folders even faster. There are a few ways to
select more than one file at a time:

If youre viewing your files as icons, you
can click and drag the mouse to draw a
box around the files you want to select.
When you're done, release the mouse; the
files will be selected. You can now move,
copy, or delete all these files at the same
time.

B| B B =+ |Documents - o x
Home  share  View v @
« v 4 % > ThisPC > Documents >

# Quick access.

@ OneDrive
= This PC
3 3D Objects
B Desktop
% Documents
& Downloads
b Music
= Pictures
B Videos
& Local Disk (C) v
6items 6 items selected E e
« To select specific files from a folder,
press and hold the Control (labelled Ctrl)
key on your keyboard, then click the files
you want to select.
B 4 ¢ = | Documents - o x
Home  Share  View v @
« v 4 5 > This PC » Documents L3 o £ Search Documents
~
; o
i b% i i dl
@ OneDrive Photos Recipes School Work Cover  Groceries_
o Documents letter  Bud ?:;,Ma
3 3D Objects.
I Desktop
'+ Documents
& Downloads
D Music
= Pictures
B Videos

& Local Disk (C:

)

Gitems 4 items selected =

To select a group of files from a
folder, click the first file, press, and hold
the Shift key on your keyboard, then click
the last file. All the files between the first
and last ones will be selected.

| ¥ 1 = | Documents _ o x
File Home  Share  View v @
« v 4 % > ThisPC > Documents v U £ Search Documents
A Name Type size
s Quick access
Photos File folder
@ OneDrive Recipes File folder
Ths PO School Documents File folder
) Work File folder
33D Objects ~
ks o Cover letter [ Microsoft Word Document 12 K8
Desitop ull Groceries_Budget March XLSX File 9KB
4 Documents
& Downloads
D Music
& Pictures
B Videos
- Local Disk (¢) Y 5
6 items. 3 items selected E =

If you want to select all files in a
folder at the same time, open the folder in
File Explorer and press Ctrl+A (press and
hold the Control key on your keyboard,
then press A). All of the files in the folder
will be selected. Ctrl+A is an example of
a keyboard shortcut.

| B = | Documents - o X
File Home  Share  View v @
« v 4 % » This PC » Documents v L P search Documents
A Name Type size
o Quick access
Photos File folder
@ OneDrive Recipes File folder
— School Documents File folder
" Work ile folder
93D Objects
ks ) Cover Letter Microsoft Word Document 12 K8
Deskicp ull Groceries_Budget_March XLSX File 9K8
“ Documents
& Downloads
D Music
& Pictures
B Videos
- Local Disk (C) Y 5
6items 6 items selected El=

2.8.9 Shortcuts

If you have a file or folder you use frequently,
you can save time by creating a shortcut on
the desktop. Instead of navigating to the
file or folder each time you want to use it,
you can simply double-click the shortcut to
open it. A shortcut will have a small arrow
in the lower-left corner of the icon.
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o Note that creating a shortcut does not create
a duplicate copy of the folder; it’s simply
a way to access the folder more quickly. If
you delete a shortcut, it will not delete the
actual folder or the files it contains. Also
note that copying a shortcut onto a storage
drive will not work; if you want to bring a
file with you, you’ll need to navigate to the
actual location of the file and copy it to the
storage drive.

« To create a shortcut, locate and right-click
the desired folder, then select Send to
Desktop (create shortcut).

Bloacl Manoge Documents

I e soe vew  Pureoos
« ~ 4 [4 » ThisPC » Documents » v U P search Document ts
A Name Type
# Quick access.
Photos =
@ Onedrive Recipes  OPe"
Open in new window
B This PC Scheel :
Work Pin to Quick access
33D Objects @ Cover!  Add to Windows Media Player list
B Desktop il Groceri  Play with Windows Media Player

* Documents Cast to Device

& Downloads @ Scan with Windows Defender...
& Music =
== Pictures

 videos

& Local Disk () v <

Gitems 1 item selected

cut * Compressed (zipped) folder
= Deskiop (reate shorteut) |1
% Documents

o A shortcut to the folder will appear on the
desktop. Notice the arrow in the lower-left
corner of the icon. You can now double-
click the shortcut to open the folder at any
time.

2.9 Learning Activities

Activity 1:
Identify a physical computer device in the workplace:

Required:
i. Identify the different parts of a computer?

ii. Identify external components of a computer
such as the mouse, keyboards, and monitors.

iii. Open a desktop computer and identify the
physical components inside the system unit.
These include the main memory, processor,
hard disk, expansion slots, motherboard
and the various ports used to connect the
computer to external devices.

Activity 2:
Open a computer and undertake various computer
processes as required below.

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE

Required:
i. Create a folder
ii. Create a file using notepad
iii. Save the file in the folder
iv. Create another text file
v. Save it in the folder
vi. Delete the file by dragging it in the recycle
bin
vii. Recover the file from recycle bin
viii. Open a word processor
ix. Close the word processor

2.10 Self-Assessment Questions and
Activities

i. What are the functions of computers?

ii. What are the benefits of using a
computer?

iii. What is the role of Windows Operating
System in  conducting  business
operations?
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3.0  CREATING DOCUMENTS USING WORD
PROCESSOR

3.1 Specific Learning Outcomes

At the end of the topic, the trainee should be able to:
i. Identify the roles of word processor
commands.
ii. Format a word processor document.
iii. Create and manipulate files and folders.
iv. Use word processing.

3.2 Introduction

This topic introduces to the student the art of
creating documents such as reports. The topic covers:
introduction to the role of word-processor, creating,
editing document; basic formatting such as bold,
italic, underline, bullets, numbering; copy, move
text; align text; set margins, insert and remove page
and section breaks; font and paragraph formatting;

create headers and footers; page numbering and
formatting; print setup, preview/print; find and
replace; create newspaper style columns; insert
pictures/objects; create, modify, format table; create
table of content; mail merge. The unit module should
emphasize the concept of preparing documents
to accomplish various organization tasks such as
reports and letters.

3.3 Word Processor Overview

A word processor is a tool for producing documents
like letters and reports. Word processor has a word
wrap feature. The latter means that once the margin
is reached the cursor automatically move to the next
line.

There are 3 parts of the ribbon namely Tabs, Groups
and Commands

Tab: There are 7 basic ones across the top and each
one of them represents an activity area

Curriculum for Digital Literacy for Custorn and Logistic Services - Word

Pens  Inset  Design  Layout  References  Mailings  Review  View

Signin  $4. Share

X Cut

Iifil
Iitl

TimesNewRo - (12 - A & Aar A 1S i 7

Em o~

P Find ~

LY ‘1.1 AcB 111111 |AaBbCel| AdBbCel AaBbCcl 1111As 111114 LIILIL | 4 .

Group: each tab has several groups which show related items. In the Home tab, we have the Clipboard,

Font, Paragraph, Styles and Editing

Curriculum for Digital Literacy for Custom and Logistic Services - Word

Pens  Inset  Design  Layout

-4 P
db Cut TimesNewRo+ |12 « A" o Aar A

Em co
Paste "
- ¥ Format Painter

B I U-acx, x> A-%-A-

1.1 AaB 111111 AacBbCcl| AaBbCcl AsBbCcl 1111 4c 111114 1111171
1 Heading..

P Find -

25 Replace
Heading 6 | TNormal | TNoSpac.. Heading2 Heading4 Heading5 Heading7 <+ [}Sele:t'

Clipboard 3 Font [} Paragraph [}

Command: a command is a button, or a box
used to enter information. It could also be a menu.

Thus, a Ribbon contain most of the commands and
button that one can use to accomplish any given
task. Most of the basic commands are under the

Home Tab.

Features can be applied while producing the
document or for an existing document. To introduce
a feature while producing the document, first
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Styles 5 Editing ~

you have to click the feature. Some feature might
require one to click them to stop the activity. For
existing document, features are mostly applied by
first highlight the desired text and then click on the
desired feature.
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3.4 Creating a New Document

Step 1: Click File

Step 2: Click New

Step 3: Double click Blank document

Step 4: Start typing

Step 5: Press enter key only when you want to create
a new paragraph

e Vo 1 - B X
syn
Protect Documert Properies*
Carmivhat g of s e ok o 5o 52t T
Pt
Docurent: ] i
— Waes {
T dirgTre Chindtes
Title ledattle
a Inspect Document. z P,
P | Berepab gt be e testeont : " - ¢ N
Q| 0 s cntpopatsandactors e " fetrrts
lsues
et Dates
LesiModfed
Mzrage Documert Crated Tedg;, ¥ 62M
Lz
etz Pecgle

Adtar
H Prof.Dalton

st
sbellsly et

SnewhlPoperis

Document1 - Word B - = x

Info

Sign in

New

New
Open Search for online templates Fel

Suggested searches: Business Cards Fiyers lefters Education Resumesand Cover Letters  Holiday

Save

Save As
Aa

Print
Share

Take a tour
Export
Close
Account Blank document Snapshot calendar ‘Welcome to Word Single spaced (blank)

Options
FIRST NAME LAST NAME

Insert your first
Table of
contents

O Type here to search

3.5 Creating Word Document

Step 1: Type desired Text

Step 2: Click File

Step 3: Click Save or Save as

Step 4: Select folder where to save
Step 5: Provide a suitable file name
Step 6: Click Save button
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Save As ®
« “ 4 | » ThisPC » Desktop » WordStore v| @] | Search Wordstore p
Organize = New folder Bz - (]
[ Desktop A Name Date modified Type Size
|| appk
|| DevCpp
|| IST4D70Assessr
L link
|| mysqgl-conned
|| New folder
~ WordStore
Documents

No items match your search.

File name: | Type desired file name| -]
Save as type: | Word Document ~|
Authors: Prof. Dalton Tags: Addatag Title Add a title
[ 5ave Thumbnsil

3.6 Opening Word Document

Step 1: Click File

Step 2: Click Open

Step 3: Select desired file
Step 4: Click Open

B open X 7 = x
+ \_}1 » ThisPC » Local Disk (C) » Users » Prof.Dalton » Desktop » WordStore v Search WordStore P Signin
Organize v New folder - m @

~

|| APT20605ummer20”  Name Date modified Type Size

@ OneDiive Noitems match your search

I This PC
8 3D Objects
I Deskiop
Documents
& Downloads
D Music
=] Pictures
B Videos
5 Local Disk (C)

I v

Fil name: | ] | All Word Documents V]

] E= UMCquide Tor drawina P

3.7 Correcting and Editing a Document

o Step 1: Use the arrow keys to move the
cursor to the position of the correction.

o Step 2: If you want to insert character, Word
will insert the character on the immediate
right of the cursor.

« Step3: You can delete using delete key. The
letter deletes the immediate character that is
on the left of cursor, backspace key deletes
the immediate character to the right of
cursor.

NB: To highlight means to select desired text, the task
is done by positioning the cursor at the beginning of
the text, then hold down the mouse button and drag
up to the desired end of text.
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3.8  Moving Text within a Document (iii) Copy and Paste
Step 1: Select the text to be copied
(i) Drag and Drop Step 2: Click Copy from Home tab (or Ctrl+C)
Step 1: Select the text you want to move. Step 3: Position cursor where to paste the text
Step 2: Position the mouse pointer over the Step 4: Click Paste from Home tab (Ctrl+V)

selection and hold down the left mouse button.
Step 3: Drag the text to the desired location and 3.9  Applying Bold, Italic, and Underline

then release the mouse. Features while Typing

(if) Cut and Paste It is possible to apply basic formats while producing
Step 1: Select the text to be cut the document. For example, to apply bold, italic,
Step 2: Click Cut from Home tab (or Press and underline click on the bold, italic and underline
Ctrl+X) buttons, continue typing and to then click bold,
Step 3: Place the cursor where you want to move italic and underline button.

text to

Step 4: Click Paste from Home tab (or Ctrl +V)

Curriculum for Digital Literacy for Custom and Logistic Services - Word

Pens  Inset  Design  Layout  References Signin 5 Share

i ;;E:;J TmesNewRo =12 -| A " | Aa~ | R 1.1 AaB 111111 AcBbCcl AcBbCcl AaBbCcl 111140 111114 111111 | ;;::m
Favste & Format Painter I U rabe x, X° ﬂvwvA' THeading... Heading6 | TNormal | TNoSpac.. Heading2 Heading4 Heading5 Heading7 |+ RSe\e:t'
The followin xt i /1 italiz Step 1: Highlight desired text
and underline. After clicking bold, italic and Step 2: click on desired feature e.g. bold, italic,
underline button, the typed text will not have those underline.
features.

3.10 Adding Bullets and Numbering while
Applying Bold, Italic, and Underline Typing Document
Features for Existing Document

Step 1: Select desired bullets/numbering from the

To apply bold, italic and underline feature for icon for bullets /Numbering

existing document, one is supposed to select the Step 2: Type Desired text

desired text (highlight) and then click the bold,

italic and underline button. Example for applying bullets features while typing
document

[cal - = x
Pens  Insert  Design Layout  References  Mailings Signin 9. Share
=J — 1— 11— e — . .
;;E:; TimesNewRo |12~ A" & Aa- fe (2= -5 B3 2l T |34 pap 111111 |AcBbGel| AcBbCel ASBHCCD 111143 111114 111111 ;:C:::m
Paste o rormatpainter | B T U v x| A~ WA~ CEial Lozl BLED Heading6 | T Normal | TNoSpac.. Heading2 Heading4 Headings  Heading7 |< | [u'co 0
Clipboard ® Font & Styles ! Editing ~
Applying Bullet Library ting Document

-
To apply E| El E| ocument, one is supposed to select the
underline button.

desired te

Baan

Define New Bullet..

10
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Select desired bullets
« Type desired text
« Continue typing

Example for applying Numbering features while
typing document

Select Desired Numbering
i.  Type desired text
ii.  Continue typing

Applying Bullet features for existing
typing document

Step 1: Highlight desired text
Step 2: Click on desired Bullet

Example
« Highlight Existing desired text
o Select Desired Bullet

3.11  Applying Fonts Formatting

Step 1: Select desired text
Step 2: From Home Font menu, select desired font,
and font size

LT nasocen nebbocoe AasbC aseboct A assbece aosbcen aosbeeax
S o | oS dgl bedrg2 T bt Soteim. G

CalkriLight
" ik
Recenty s ont
O Times New Roman
0 Arial Black
0 Bahnschrit Semiold
0 Taroma
Mfonts
0 hay
0 ALGERIAN
0 Al
O Arial Black
0 i Merow
0 Arial Rounded T Bold
0 sl Unicode M3
0 Bahnschritt
O Emscrittondensed
0 BehnschritLight
O BamssitlightOngnsd
0 BnschriLight Senicondensed
0 Behnschrit Semiold

sules 5 s

] = B -+ o

Fge1of 1
H O Type hereto search

Alternative approach to applying fonts to existing
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document

Step 1: Select desired text

Step 2: Right click mouse button

Step 3: Select desired Fonts or desired Effects

LY Jnsmncend nesbceoe AaBbCe assbeet AGB assocer aas
Tox | T s s

feprict e 050
Ho'ywhemmsealch s BB

3.12 Applying desired Paragraph
Formatting (Alignment, Indent, and
Spacing)

Step 1: Highlight desired paragraph
Step 2: Select desired paragraph format
Step 3: Click OK

N o I

drg?  Tae St

pageiotl owoss 2 8
= R

3.13 Applying Numbering features for
Existing Document

Step 1: Highlight desired text
Step 2: Click on desired Numbering

Example
1) Highlight Existing desired text
2) Select Desired Numbering
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3.14 Applying Colours for Existing
Document

Step 1: Highlight desired text
Step 2: Click on desired Color

Example
Highlight Existing desired text. Select Desired color

Curriculum for Dig e om and Logistic S ore cal - (=] x
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Standard Colors

3.15 Applying Indenting Features in an
Existing Document

Step 1: Position cursor anywhere within the desired
text (or highlight the entire desired text)
Step 2: Click on desired indent button

Curriculum for Digital Literacy for Custom and Logistic Services - Word

Pens  Insert  Design layout  References  Mailings  Review  View Sign in f;_’*_ Share
ey ¥ Cut P B PFind -
' TimesNewRo |12 - A A" Aa~ & 11 AaB 111111 AcBbCcl| AdBbCel AsBbCcl 11114 111114 111111
ER) Copy ~ | %cReplace
. : Laby - - ’ ) -
¥ Format Painter I U-~ax, X A z A THeading.. Heading6 | TNormal | TNoSpac.. Heading2 Headingd Heading3 Heading7 - %Se\ect'
Clipboard [} Font [} Paragraph r} Styles n Editing A

Example Increase Indent

Move your paragraph farther away
from the margin,

Example
This text is indented to the right.
This text is also indented to the right

3.16 Aligning Text Left, Center, Justify,
Right

Step 1: Highlight Desired text

Step 2: Click on Left/Center/Justify/Right alignment
button
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T L‘;E:;y TimesNewRo =[12 - A a7 A2~ ¢ 11 AcB 111111 |AaBbCel| AdBbCel ASBOCCL 111143 111114 11IIIT | g
Pt bt | B I Ucaxx A-%-A- B THeading.. Heading 6 | TNormal | TNoSpac.. Heading? Heading? Headings Heading? = [ o
Clipboard ) Font 1] Paragraph 1] Styles 1] Editing ~
Align Left (Ctrl+1) I
Align your content with the left 2l
margin.

Left alignment is commonly used
for body text and makes the
document easier to read.

Aligning B - t

Qtant- Wiahlicht Nacirad tavt

Alternate Approach to Align Text

Step 1: Select the paragraph

Step 2: In the Home tab, Paragraph Group select the
alignment you want

Step 3: To center align text click the Center button,
to align left click Align Left button, to align right
click Align Right button, to align on both sides
click Justify button.

cal - x

Pens  Inset  Design Mailings Signin £, Share

B X, Cut — 2 P Find -
Calibri (Body) |11 ~| A" A A2~ fo LT | pagbcene | Asebcene AaBhbC( AaBbCcl /—\aB AaBbCCL AaBBCCD: AaBBCCD

Pac B Copy - 23 Replace

e . S =

* & Format Painter B I U-asx, x [ T Mormal | T No Spac. Heading 1 Heading 2 Title Subtitle  Subtle Em. Emphasis | h Select -
Clipboard ) Font Paragraph ) Styles f Editing A

3.17 Inserting Page Numbers, Headers,
Footers, and Tables

Inserting Page Numbers
Step 1: From Menu click Insert
Step 2: Click Page Number

Step 3: Select Desired Position

H -0 o Curriculum for Digital Literacy for Custom and Logistic Servic

File Home Pens Design Layout e Mailings Review View Signin ﬂ_ Share
B CoverPage~ % @ @ T Smartart i store W E’ﬂ 2 Hyperlink + [} Header~ A= [l Quick Parts~ [ Signature Line - T Equation ~
[ Blank Page .| 1l Chart ® I Bookmark [ Footer~ — 4 WordArt~ ) Date & Time € Symbol -
- Table  Pictures Online Shapes ‘ My Add-ins ~ Wikipedia  Online Comment Text A
'— Page Break . Pictures + s Screenshot ~ oy Video E|j Cross-reference [2] Page Number = Box~ Drop Cap~  [~]Object =
Pages Tables Illustrations Add-ins Media Links Comments Header & Footer Text Symbols ~
Add Page Numbers
Example Eumb&rthe pages in your
o . locument.
Thus text 1s indented to the right.
This text also is indented to the right Vou(arj choose from a variety of
pre-defined looks or select your
own format,
e Tell me more

Inserting Headers and Footers
Step 1: From menu click Insert

Step 2: Click header/Footer
Step 3: Type Desired header/Footer
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Design L: s Mailings

5 = = = = = =
BS Cover Page % ’_—‘EI Q rT) T SmartArt 8 store Avea E:é B Hyperlink [A=| El Quick Parts [ signature Line 7T Equation
[ Blank Page B Crmss Guf Sh: 11 Chart Wikiped o I™ Bookmark o= N Built-in ymbol ~

able | Pictures Online Shapes . . ins - Wikipedia Online
= Page Break . e 2 M S | L DPAEETS Video = Cross-reference Blank
Pages Tables Niustrations Add-ins. Media Links Comments symbols ~
et

Blank (Three Columns)

Austin

Banded
More Headers from Office.com >
Edit Header

P08

Remove Header

Fia Save Selection to Header Gallery..

Inserting Tables and Formatting
Tables

Step 1: From menu click Insert

Step 2: Click Table

Step 3: Select desired number of columns

Step 4: Type text in the first cell. Move to the next
cell using mouse or tab key

Step 5: To add a new row, move to the last column
and press tab key

Step 6: Select the table

Step 7: Right click mouse button

Step 8: Apply desired format.

H -0 -

File Home Pens Design Layout References Mailings Review View Signin & Share

N o = i r o o ; > S
Bj Cover Page % il @ @ ) SmartArt 8 store W E:é &, Hyperlink j [ Header [E Quick Parts - [ Signature Line TL Equation
[ Blank Page = o'l Chart | Bookmark [ Foater ~ 4 WordArt- B Date & Time Q) Symbol ~
= Table | Pictures Online Shapes . . & My Add-ins ~ Wikipedia  Online Comment Tet
¥ Page Break > Pictures ~ @ Screenshot~ P Y Video = M Cross-reference [) Page Number~ = poy. “ DropCap - []Object ~
Pages 3x1 Table Add-ins. Media Links. Comments Header & Footer Text Symbols ~

0

F0 Insert Table.

[ Draw Table

=h Convert Text to Table...

@ Excel Spreadsheet

B Quick Tables 3

- ot —— -
7 Shading | Border Borders
[¥] Banded Rows [] Banded Columns = e Epencolor | e o

Table Style Options Borders 5 -~

Column2 Columnz.

> B Autofitto Contents

] Window
= olumn Width

Pagelof1 3of3words (2 £

O Type here to search
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3.18 Changing Layouts Margins,
Orientations, Breaks and Columns

Changing Layout Margins
Step 1: Select desired text
Step 2: From Layout menu, select desired margins

Pagelof1 Owords [ &

o
2

Q Type here to search o}

Changing Layout Orientations

Step 1: Select desired text

Step 2: From layout menu, select desired orientation
(Portrait/Landscape)

Bowweim fl: meocoronna oo

Changing Layout Columns

Step 1: Select desired text

Step 2: from layout menu, select desired column
numbers

[« [ N-sso0comd
Changing Layout for Page breaks

Step 1: Position cursor at the desired location
Step 2: Click layout

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE

Step 3: Select desired breaks

Margins Orientation  Size 1| P Wiz
- - - Page Bpt - Text
e Mark the point at which one page ends.
and the next page begins.
Column.
Indicate that the text following the column
break will begin in the next column,
T
eparste text around objects on web
385, such a5 caption tertfrom body tert.
Section Br
= Insert 2
=5
L, Co
s
= secti
ES
=
Pagelof1 owords [2 83

QO Typehere to search

3.19 Spell Check a Document

Step 1: Click on the Review tab to access the Proofing
group

Step 2: Position the cursor at the beginning of your
document

Step 3: Click on Spelling & Grammar command in
the Proofing tab

Step 4: Choose or ignore the specific word or add it
to the dictionary

Step 5: To accept the suggested change choose the
Change button

Step 6: Click Ok button

Using the Thesaurus

Step 1: Click inside or highlight word

Step 2: From Review tab, in the Proofing group, Click
Thesaurus, The Research pane appears alongside the
document.

Step 3: Under Search for the word “purpose” is
selected and the type of Thesaurus is also indicated.
Step 4: Choose a word from the list and click Insert

Printing a word document
Step 1: Type desired text

Step 2: Click File

Step 3: Click Print

Step 4: Select desired print format
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Document15 - Word 2 - =] x

Print

Copies: |1 :

b
I

k4

int

Printer

EPSON 1220 Series
'ﬁ Offline

Printer Properties

Settings

Print All Pages
The whole thing
Print One Sided

Only prnk on one side of th..

= Collated
(E[E| 1,2,;1,13 123

Partrait Orientation

D Letter81/2x 11 in
85" x11"

Normal Margins
Left: 1" Right: 1"

1Page Per Sheet . L

Page Setup 1 Qm » 5% -+ [

-] O Type here to search

3.20 Learning Activities 3.21 Self-Assessment Questions and

Activities
In one of the class units, identify a document, a
report or an assignment you are working on. Process L

What is the role of the word processor?
the activity on the computer.

How can you use the word processor in the
organization?

What are the critical issues in developing
and formatting a word document?

Required: 3.
(i) Using any information for the certificate
program that the students are pursuing,

a. While typing the document introduce
featuressuch as bold, jitalic,underline
in some parts of your document

b. Format some key points with
bullets and other sections with page
numbering

(ii) Continue typing the text and produce
at least 4 new paragraphs. In those new
paragraphs introduce the following
formatting features:

a. Bold, underline, bullets

b. Align the margins with Align Justify

c. Colour some parts of the documents

(iii) Continue typing and this time insert a
table of 4 columns. Key in any relevant
details and format your table accordingly

(iv)Create page breaks

(v) Insert page numbers are centred

(vi)Introduce headers and footers in your
document

(vii) Save your document with any name of
your choice
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4.0  CREATING SPREADSHEETS
4.1 Specific Learning Outcomes
At the end of the topic, the trainee should be able to:
i. Identify the roles of spreadsheet
commands

Create a worksheet

Format a spreadsheet document

Create charts from data in a spreadsheet
Analyse data in a worksheet

Solve problems using spreadsheet

ii.
ii.
iv.
V.
vi.
4.2 Introduction
The topic introduces the student to the art of solving
problem using spreadsheet. The topic covers,
introduction to the role of spreadsheet; creating
worksheet, selecting range; editing worksheet;
formula and in-built functions; filling data; cell
formatting (number, text, date, percentage); font
formatting; applying borders; inserting/editing
chart; data decision analysis using WHAT-IF
analysis, COUNTIF; printing; page setup. The unit
module should emphasize the concept of preparing
worksheets to accomplish various organization
tasks such as maintaining records, analysing data,
and making decisions.
4.3 Overview of a Spreadsheet
A spreadsheet is a computer application
for organization, analysis, and storage of data in
tabular form. A spreadsheet is made up of rows
and columns. Rows are labelled with numbers and
columns are labelled with letters of alphabet. A cell
is an intersection between a row and a column. A

cell is named using Column letter and Row Number
e.g., A3.

4.4 Starting a New Excel Worksheet

Step 1: Click File
Step 2: Click New
Step 3: Click Blank workbook

Open

@ Recent
-,
=

+

OneDrive

This PC

Print

Add a Place

Share

Browse

O Type here to search

> AutoSum T

= =
0 = Calibri AT = £ B Wrap Text G @) Eﬂ == %& E =
ER) Copy - Fill -
B I U- ©- M- A === =3 ElMagetiCenter - § - % » |3 5 Conditional Formatas Cell  Insert Delete Format Sort& Find& P
¥ Farmat Painter & & * Formatting~ Table~ Styles~ - £ Clear~  Fifterv Select~
Clipboard & Font = Alignment " Number " Styles Cells Editing New G ~
=] © (A V| B L H-
021 - £ A
| A | B | C | D | E | F | G | H | | J K | L | M | N o] P | Q | R | S | T | u
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Book1 - Excel & - x

New

New

Open Search for online templates yel

Suggested searches:  Business  Personal  Planners and Trackers  Lists  Budgets Charis  Calendars

Save

Save As

Print A s c
Share :L -I Get started with Make your first Get to know
- B Take a tour Formulas PivotTable Power Query
upo

a4
Publish 5

¢ >
Close 7

Blank workbook Welcome to Excel Formula tutorial PivotTable tutorial Power Query tutorial

ount

Options

Jr T Personal Budget
Apla0xx __?‘i_ﬁﬁ September20.... Wi

Going beyond
Pie charts

Get more out of
PivotTables

Get mare aut nf PiuniTahles Seacnnal nhatn ralendar

O Type here to search a
4.5 Navigating in a Worksheet

It can be performed by any of the following:

(i) Using mouse to move to any cell a
worksheet

(ii) Using tab key to move from one cell to
another

(iii)  Using navigation keys such as arrows,
page up and page down keys

4.6  Adding Datain a Spreadsheet

To enter any data in a worksheet, the following steps
are applied:

Step 1: Move cursor to desired cell location e.g., A2
Step 2: Type desired data

Step 3: Use the mouse or tab key to move to another
cell. Pressing enter key move cursor to the next cell
below

[cal - x

Insert  Page Layout Formulas Data Review View Developer ell me what you want to do Signin £ Share
—J P [ma] =31 o i
% Cut Calibri A = Se Wrap Text General - EE' 2 e . AutoSum Ay p \id
E® Copy + [E3] =] Fill~ - L
Paste B I U- &iec Mep. === 5 Merge& Center - § - % 3 % g3 Conditional Formatas Cell  Insert Delete Format Sort& Find&  Pens
.~ ¥ Format Painter =Tl 4 =l Farmatting~ Table~ | Styles= | - - + | & Clear~ Filter - Select -
Clipboard r. Font [ Alignment 5] Mumber = Styles Cells Editing Mew Gro...  ~

H - &- i 4 L B~

F7 < Se -
4 A | B | ¢ | D | E | F | 6 | H | v [ ¥ | ¥k | L | M | N | © | P | Q@ | R | s | T | ul
El 2020 2021

4 |Maize 1200 3400

5 Beans 4000 5600

6 Cassava 5000 6500

7 |:I

8
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4.7 Saving a Worksheet

It is important to continue saving a worksheet all the
time. The following steps are applied to permanently
save new or existing worksheet

Step 1: Create worksheet

Step 2: Click File

Step 3: Click Save or Save as

Step 4: Select desired folder

Step 5: Provide desired file name

Step 6: Click Save

B save As X - Bxcel
<« ~ 4 | ThisPC » Desktop > Wordstore v| @] | SearchWordstore »
Organize = New folder Bz - [~]
I Desktop A Name Date modified Type
appk
Mo items match your search.
DevCpp
1ST407DAssessr
link
mysql-conneet
New folder
WordStore
De it
ocuments 5
File name: | Type desired file narme| v‘
Save as type: | Excel Workbook v
Authors: Prof. Dalton Tags: Addatag
[ Save Thumbnail

4.8 Using Excel as a Simple Calculator to
Add, Subtract, Multiply and Divide

We use the following mathematical operators
(+) Sign for addition

(-) Sign for subtraction

(*) Sign for multiplication

(/) Sign for division

Examplel: Adding

Step 1: Enter data

Step 2: Move cursor the cell where the formula will
be displayed

Step 3: Type =

Step 4: Use + sign and cell address to combine all the
range for the values to be summed, e.g., C3+C4+C5
Step 5: Press Enter key

Step 6: To copy the formula to other area, position
cursor at the button corner of the cell that has the
formula. Wait until a small sign + appears and then
hold down the mouse button and drag to the cells to
receive copy of the formula.

Example 2: Dividing

Step 1: Repeat examplel

Step 2: Position cursor where you want the formula
to appear

Step 3: Type =

Step 4: Type the cell with the value to be divided say
C6 followed by /

Step 5: for this example, type 3 and enter

Step 6: repeat the step6 as shown in example 1

Inset  Pagelayout  Formulas  Data  Review  View  Developer

o s v =
D i Calibri KN E== @ BWepTet General
paca 2 Copy - N
§ 3  Farmat Painter BIU- 5. O A =S== E% EMegellenter - §- %
Clipboard F} Font [F1 Alignment [F1 Num
B - ¢ i~ 4 4 #H-
C6 | Fo|| =Caremcs
A A ¢ ¢ b | E F | &6  H
1 Example of Testing Adding and Dividing
2 Examl Exam2  Exam2
3 James 67 36 69
4 Henry T8 89 7
3 Peter 57 45 35
6 [Adding Total 202. 190 176
7 Dividing Average  67.33333 63.33333 538.66667
8 El

4.9 Applying Simple Formula to
Worksheet

Example Summing Number:
highlighting technique

Step 1: Create desired Worksheet

Step 2: Position Cursor where the formula will be
inserted

Using

Step 3: Press = sign

Step 4: Type desired function sum

Step 5: Open blanket

Step 6: Highlight desired data range and close

blanket
Step 7: Press return/enter key

Insert Page Layout Formulas Review View De
= - =
% Cut n AW === % e Wrap T¢
. ER Copy ~
aste £ === ==
I | S 2 U =8 O- A == = | == EMeget
Clipboard ] Font Alignment
B S ¢ i 2 £ ®©
B4 i X & J || =sum(B4:B6
‘| A B e | D | E | F | G | H |
32 2020 2021
4 |Maize 1200 3400
5 |Beans 40001 5600
6 |Cassava 5000 6500
7 |Total :sum(B4:BS|
8 SUM(number1, [number?2], ...}
o
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Example Summing Number: Using
typing cell address method

Step 1: Create desired Worksheet

Step 2: Position Cursor where the formula will be
inserted

Step 3: Press = sign

Step 4: Type desired function sum

Step 5: Open bracket

Step 6: type cell address for starting data

Step 7: type a dot or full colon and then type the
cell address for the ending data

Step 8: Close bracket and then press enter key

Insert Page Layout Formulas Data Review View

ol %Cut

0 N AN === % | EWep
b ER) Copy -

aste === |e=3=

- ' Farmat Painter o - O- A === |8=2= ME’Q

Clipboard [F} Font Alignment

B - ¢ -y~ 4 £ ©
COUNT - X K | =sum{bd.bé
A A B c | D E | F | G | H |
3 2020 2021
4 |Maize 1200 3400
5 |Beans 4000 5600
6 |Cassava 5000 6500
7 (Total =sum{b4.b)
8 SUM(number1, [number2], ...}
El

NB: Use the following inbuilt functions to perform
simple statistical tasks
(i) Average to get mean of a range of

values

(if) Max to get maximum of a range of
values

(ifi) Min to get minimum of a range of
values

(iv) Count to get the total numbers in a
range of values

4.10 Changing Columns and Row Size width

Step 1: Position cursor at a beginning of a desired
column or row
Step 2: Drag to resize accordingly

Alternatively, position cursor at the beginning of a
column and then double-click. The column will be
resized to the width-size of the longest data entry in
that column
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Formulas Data

e . - —
% cut Calibri -l LA s =
Paste Ea Copy - Iy =
- & Format Painter | B 1 W - |- A=

- EFwrar

=53= Merg
Clipboard ]

H - - - # £ ®-

Font ] Alignment

F9 ~ S
P A B c o | E F 6 | H |
3 2020 2021
4 Maize 1200 3400
5 Beans 4000 5600
6 |Cassava 5000 6500
7 |
8
5 1
10
11|

4.11 Inserting Blank Rows and Blank
Columns

Step 1: Position cursor at a desired location (row or
column)

Step 2: Right click mouse button

Step 3: Select desired option (row or column)

Page Layout Formulas

=y M Cut

Og .
Paste E Copy

Calibri 11 A A=

B I u- H- &-a4a-

~ Format Painter

Clipboard = Font =

H - - i~ # <2 ®-

c1 i k]
A | B | c | D E F
L1
| 2020 2021
Maize 120000 | = annon |
Beans Insert 7 =
Cassava — [
O sl b
@] 5
O Entire row L e
() Entire column L

Gance

] I AT ol el N
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4.12 Applying Borders to Worksheet

Step 1: Select desired text
Step 2: Sect desired borders from border icon

Insert Page Layout Formulas
&D ‘x’ it Calibri 8- S* Wrap
Paste B2 Copy - B I U =3x= EHm
- " Format Painter . === ere
Clipboard [ ignment
= S = \id : Bottom Border
Top Border
A3 - Left Border
Right Border |
) A B = ;i Mo Border H
3 2020 2021 EH ANl Borders
4 |Maize 1200 3400 Outside Borders
51| B 1y Eitg [ Thick Outside Borders
G |Cassava 5000 6500
e Bottom Double Border
s | Thick Bottom Border
9 | Top and Bottom Border
10| Top and Thick Bottom Border
:;7 ZE  Top and Double Bottomn Border
Eel Draw Borders
14 | [ Draw Border
15 | [ Drsw Border Grid
g & Erase Border
17 LZ Line Color >
18
ol Line Style »
20 HH More Borders...
21 - :
2>

4.13 Applying Basic Format such as bold,
italic, underline, bullets, numbering

Step 1: Highlight (Select) desired text
Step 2: Click on desired feature

4.14 Applying number formatting with
commas and decimal

Step 1: Select desired cell or range of cells
Step 2: Click desired number format like commas

and decimal

2020

2021

Maize

1,200.00

3,400.00

Beans

4,000.00

5,600.00

Cassava

7,220.00

11,021.00

Alternative approach

Insert

Page Layout

Formulas

Data

Review

View  Developer

4.15 Applying Font Cell Format

Step 1: Select desired cell or range of cells
Step 2: Right click right mouse button,
Step 3: Select relevant format cell

Insert Formulas Data Review View

Page Layout

L] P
o cut Calibri iAo
Bl Copy ~
Paste B &A=
> ¥ Fomat Painter | > 1 U H- &A=
Clipboard 5 Font 5 Alignment 5
B - ¢-ji- 4 £ ®H-
B6 M fe || =SUM(B3:B5)
L
Format Cells 7 X
’Number, Alignment Font Border Fill Protection
Category:
| Sample
7,220.00
Decimal places:
Symbol: |Nun=

Accounting formats line up the currency symbals and decimal points in a column,

| Co] om |

4.16 Sorting Data in a Worksheet

Step 1: Select desired worksheet

Step 2: Click on Sort icon

Step 3: Select Sorting order or customize sort by
specifying the column to sort with

Signin 53, Share

@ Eﬁ %ﬂ %(@ ZAumSum'%Y p .”-

-
3 cut Calibri -1 = - EewnpTet General
P BB Copy - Conditional For Cell | Delete Fo i Sort& Find & P
aste BIU-H- - === T=E EMege&Center - $ - % 2 W% nditianal Format as nsert lete Format rt in ens
- ¥ Format Painter 4 9 M e T Snme - o & Clear~ Filter= Select -
Clipboard [ Font [ Alignment [ Number [ Styles Cells Editi ?l Sort AtaZ 0. A
H ©- - i %A 2 B il SertZten
1 Custom Sort...
- N
B1 5 Y CEilter
YW Clear
4 A B C D E F G H | K | L M N | O P 9 | R Reoppy
1 2020 2021 T
2 Maize 1,200.00 | 3,400.00
3 Beans 4,000.00 | 5,600.00
4 Cassava 7,220.00 | 11,021.00
5
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4.17 Inserting Charts in a Worksheet

Step 1: Select desired range of worksheet
Step 2: Click Insert
Step 3: Select desired chart e.g., Bar, Pie, Line

% ALl

D~ L] s | pla i
Store a e, e
B lalgz A= FZ Jou T2
PivotTable Recommended Table | Pictures Oniine ins ~ o | Recommended Line Column Wi
PhvotTables e | CIRESTS ° (5] M Lo
Tables ustrations Adein Sparkdines
H S- ¢ i~ 4 £ ®#- 3-D Column
- 2 fn a3 03 59
4 A |IE c DBl : | r | G | wu |ZPRe L™
H T o
2] Maize 1,200.00 | 3,400.00
i Beans 4,00000 | 5,600.00 o
L Cassava | 7,220.00 [ 11,021.00
5 |
g
7
zl More Column Charts
a b
9|
1]
|
2]
1]
i
0
1]
]
18]
4.48 Format Chart

Step 1: Select created chart

Step 2: Select chart elements

Step 3: Type chart elements
« Add title and axis labels
« Changing the axis range
« Changing the chart styles
o Add Legends and values

Signin S Share

Data Review View

By o | [

Add Chart Quick  Change Switch Row/ Select ~ Change  Move
Element ~ Layout = Colors = - Column  Data  Chart Type Chart
Chart Layouts Chart Styles Data Tpe Location ~
H - e -ii- 4 4- ©®
Chart1 ' I3 @
A A C D E | F | G | H | | J | K | L | M | N | o | P | Q | R | 5 | T | z
1| 2020 2021
2| Maize 1,200.00 | 3,400.00
3 | Beans 4,000.00 5,600.00
4 Cassava 7,220.00 | 11,021.00 [} 5 o Q
— = | Chart Elements
5 Cereal Produce
i 5 ) Add, remove or change chart
= 12,000.00 elements such as the title, legend,
7| gridlines, and data labels.
s 10,000.00 =
5 g Boooo
10 2  6,000.00
1 2
L £ 4,000.00
n . I I
=1 2,000.00
13 g
] )
15 Maize :Earnsl Cassava
13 is Title
) w2020 w2021
18 | O o]
19 a4 L
2]
| sheett [ @
Ready 7
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4.19 Decision Analysis

We can perform simple data analysis using if
function. The if function checks whether the
condition is true, if the condition is true then a
relevant message for true is displayed otherwise a
relevant message for the false condition is displayed.

2] i [ Checks whether a condition is met, and returns one value if TRUE, and another value if FALSE
%) IFERROR
@ IFna

BEsiaaiss2ae

Example: Assume we got a list of students marks for Insert  Pagelayout  Formulas
three different exams. The pass mark is 60 %. "D EJECut calibr Tn & a|==l®- =
E@ Copy -
Pz . BIU-MA- H-A- === == E
. .. . . . - ~ Format Painter
Thus, to perform simple decision analysis using if Cipbons . . . -
function, we proceed as follows: H ©- - \i- 4 £ ®-
Step 1: Position cursor at desired location
Step 2. type — F4 - J || =IF(E4>60,"Pass","Fail")
Step3:typelf(. 4 A | e | ¢ | b | E F . 6 | H
Step 4: Type desired formular e.g., E4>60, =
tep 5: Type ass”, 2 Grading System
S P yp “p 1 3 Examl |Exam2 |Exam3 |Average |Grade
Step 6: Type Fail”) 4 [sames 67 56 45 56| Fail
5 |Alice 78 89 68| 78.33333|Pass
6 |Oloo 25 34 54| 37.66667|Fail
7
8 |
4.20 Printing Worksheet
Step 1: Select desired worksheet
Step 2: Click File
Step 3: Select desired worksheet format

Print

=

Print

Copies: |1 =

Printer
EPSON L220 Series

8 oine T

Printer Properties

Settings

@ Print Active Sheets -
Only print the active sheets
Pages ol 7

= Collated
BB 2. e T

Portrait Orientation -

D Letter81/2x 11in
&5 x11"

Options: .

Normal Margins
Lef: 0.7 Right 07"

(01 Ne Scaling

(uo  print sheets at their actual size

Page Setup

[T Jert > i El

QO Type here to search
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4.21 Learning Activities
Open a new worksheet

Required
(i) Identify cells,and worksheets, and reference
cells and worksheets
(ii) Create a new worksheet using data
information for the current certificate
course enrolled. The worksheet should
both text, numbers, and date.
(iii) In that worksheet show how to compute
the following statistical tasks
a. Adding
b. Averaging
c. Formatting with commas
d. Formatting with percent (%)
e. Formatting with date
(iv)Save your works with any name of your
choice
(v) Retrieve your worksheet and perform the
following tasks
a. Change row height and column width
b. Introduce borders and shading in your
worksheet
c. Perform decision analysis using if
function
d. Create two charts, bar and pie chart
and format them accordingly

4.22 Self-Assessment Questions and
Activities

1. What is the importance of worksheets?
How can worksheets be used in enhancing
the performance of a freight and logistics
company?

3. Identify the various parts of the spreadsheet
environment.
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5.0 ORGANIZING DATA IN A DATABASE
5.1 Specific Learning Outcomes

At the end of the topic, the trainee should be able to:
i. Identify the roles of databases in an
organization
ii. Create a database table
iii. Create a database form
iv. Create a database query
v. Create a database reports

5.2 Introduction

The topic introduces to the student the art of
organizing data in a database. The topic covers,
introduction to role of database; create, modify
table, sort, and filter records in a table; create queries;
calculate, sort and filter data in a query; create/work
with data on forms; create reports, add controls to a
report, enhance the appearance on report, prepare
report for print, organize report information, format
reports. The unit module should emphasize the
concept of using databases to maintain and analyse
records in an organization.

5.3 Overview of Database

Microsoft Access is a Database Management System
(DBMS) from Microsoft that combines the relational
Microsoft Jet Database Engine with a graphical user
interface and software development tools.

Importance of Database

o Itstores data

o Allows you to link related information
easily.

o It can also import or link directly to data
stored in other applications and databases.

o You can export data to and import data
from word processing files, spreadsheets, or
database files directly.

Creating Ms Access

- Database Creation - Create your
Microsoft Access database and specify what
kind of data you will be storing.

- Data Input - After your database is
created, the data of every business day can
be entered into the Access database.

« Query - This is a fancy term to basically
describe the process of retrieving
information from the database.

« Report (optional) - Information from the
database is organized in a nice presentation
that can be printed in an Access Report.

Table

Table is an object that is used to define and store
data. When you create a new table, Access asks
you to define fields which is also known as column

headings
o Each field must have a unique name, and
data type.

o Tables contain fields or columns that store
different kinds of data, such as a name or an
address, and records or rows that collect all
the information about a particular instance
of the subject, such as all the information
about a customer or employee etc.

+ You can define a primary key, one or more
fields that have a unique value for each
record, and one or more indexes on each
table to help retrieve your data more quickly.

Query

An object that provides a custom view of data from
one or more tables. Queries are a way of searching
for and compiling data from one or more tables.

« Running a query is like asking a detailed
question of your database.

«  When you build a query in Access, you are
defining specific search conditions to find
exactly the data you want.

o InAccess, youcan use the graphical query by
example facility or you can write Structured
Query Language (SQL) statements to create
your queries.

o You can define queries to Select, Update,
Insert, or Delete data.

o You can also define queries that create new
tables from data in one or more existing
tables.

Form

« Form is an object in a desktop database
designed primarily for data input or display
or for control of application execution. You
use forms to customize the presentation
of data that your application extracts from
queries or tables.

o Forms are used for entering, modifying,
and viewing records.

o The reason forms are used so often is that
they are an easy way to guide people toward
entering data correctly.
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o When you enter information into a form
in Access, the data goes exactly where the
database designer wants it to go in one or
more related tables.

Report

Report is an object in desktop databases designed for
formatting, calculating, printing, and summarizing
selected data.

«  You can view a report on your screen before
you print it.

o Ifforms are for input purposes, then reports
are for output.

« Anything you plan to print deserves a
report, whether it is a list of names and
addresses, a financial summary for a period,
or a set of mailing labels.

o Reports are useful because they allow you to
present components of your database in an
easy-to-read format.

« Youcanevencustomizeareport’sappearance
to make it visually appealing.

o Access offers you the ability to create a
report from any table or query

5.4  Starting Ms Access
Step 1: Click File

Database1: Database- C:\Users\Prof. Dalton\Documents\Databasel.accdb (Access 2007 - 2016 file format) - Access - =} X

Sign in

New
Databasel
Open Documents
Sove = Compact & Repair View and edit database properties
it Help prevent and correct database file problems by using Compact and Repair,
Save As Compact &

Repair Database

Print

Close

= Encrypt with Passwaord
Use a password ta restrict access to yaur database. Files that use the 2007
Encrypt with Microsoft Access file format or later are encrypted.

Account Password

Options

O Type here to search
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Databasel : Databast 3 f.D \Documents\Databasel.accdb {Access 21 6 file format) - Access E b4

Signin

= = X cut Y Ascending Y Selection = New 2 Totals p b Replace

= Bl Copy Descending =) Advanced ~ o Save " Spelling 3 GoTo~
View  Paste resh Find BIU A-%.5

. ¥ Format Painter Remove Sort | ToggleFilter  pj~ X Delete - ] More~ [3 Select~ = B
Views Clipboard i) Sort & Filter Records Find Text Formatting 7] ~
All Access Obje... ® «
Search.. P E
. el Asset List

ER Assets

R contacs Em] New Asset nj E-mail List Contact List ShowyHide Fields [ show Retired ?
H Fitters Open v‘ Item -| Category - ‘ Condition - | Location v|Purchase Price ~ | Current Value ~ | Owner - |Acquired Date v| ]
B Settings *‘ (New) (1) Category (2) Good $0.00 $0.00 o)
Queries %

B Assets Extended

EFl Assets Retired

B Contads Extended
Forms ES
Asset Details

Asset List

Contact Assets Datasheet ...

Contact Details

Contact List

Filter Details

Welcome

3
bl
-]
2
@
»

All Assets
Asset Details

Assets by Category

El

Assets by Lacation

Asset 0 <[ |+ v [ W Fittered | [Search ]

Form View

0 Type here to search

5.5 Creating Database Table

Step 1: Click Create

Step 2: Click Table Design

Step 3: Provide a suitable name for the table

Step 4: Enter Fieldnames, and also specify the Data

Databasel : Database- Ct\Users\Prof. Daltor\Documents\Databasel.accdb (Access 200

Create External Data Databas T ne at you want to do Sign in
[E Form Wizard = E =
===l ~==| sl SEE| [N =] 7l Report Wizard
Tabl Table SharePoint Qi = Qu For For Blank B Navigation - R rt R rt Blank M:
able Table SharsPoint Query Query rm Form  Blan eport Report Blank |5 - lacro
ign  Lists~  Wizard Design Design Form [=] More Forms - B e 5| Visual Basic
Templates Tables Queries Forms Reports Macros & Code ~
B =] Asset List\ >
All Access Obje... ®@ « !
Search. el H
B sl Asset List
EH Assets 002000 | ST YT
T conteas =] New Asset "7 E-mail List Contact List Show/Hide Eields  [] Show Retired ?
EA Fiters Open - ftem ~ | Category - |Condition ~ | Location « | Purchase Price ~ | Current Value ~| Owner « | Acquired Date «| @
A settings *‘ New) (1) Category (2) Good $0.00 $0.00 d(o)
Queries ES

S assets extenced
Assets Retired

Asset Details
Asset List
Contact Assets Datasheet ...

Contact Details

Contact List
Filter Details

Welcame

Asset Details
Assets by Category
Assets by Location “\[Asses W [ 17 nv [Feneeal searen

Form View

QO Type here to search a
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Database] : Databas uments\Database].accdb (A 0 mat) - Access ? X

External Data Databas T

Ez &= Insert Rows % &ﬁj‘m = :

3 Delete Rows
View  Primary Builder Test Validation Property Indexes Create Data  Rename/  Relationships  Object

Sign in

=
- Key Rules  EQModify Lookups  gpeet Macros~ Delete Macro Dependencies
Views Tools Show/Hide  Field, Record & Table Events Relationships ~
; Asset Lis Tablet x
All Access Obje... @ « ERETTNERTTN
Field Name | Data Type Description ({Optional)
Search.. Pllg
— D AutoNumber
Tables = FirstName
B Assets
E5 contacts || Long Text
B3 Fiters | Number
Date/Time
B settings 1 /T
[ | Currency
B Tablet | | AutoNumber
Queries 2 Yes/No
£ Assets Extended || OLE Object
EF Assets Retired | Hyperlink
Attachment
= Contacts Extended 1
= Calculated hd
Forms # Lookup Wizard... Field Properties
B Asset Details
= General Lookup
Asset List Field Size 255
Contact Assets Datasheet . Format
i Input Mask
Contact Details LI caption
- Default Value
Contact List Validation Rule The data type determines the kind of values
Filter Details Validation Text that users can stare in the field. Press F1 for
- Required No help on data types.
Welcome Allow Zero Length Yes
Reports & Indexed No
2 Unicode Compression _ Yes
E A asset
= et IME Mode N Control
Asset Details IME Sentence Mode  None
Test Align General
B8 Assets by Category -
Design view. F6 = Switch panes. F1 = Help. 174

H O Type here to search

Adding Data in a Table

Step 1: Click on the Table

Step 2: From View Click on Datasheet View

Step 3: Add Data

Step 4: Move to the Next Field using Tab Key

Step 5: Press Tab key while at the end of last field in
order to generate a new blank row

Tab Databasel: Database- Users\Prof. Dalton\Documents\Databasel.accdb (Access 2007 - 2016 file format) - Access

External Data Database Fields Table

e X cut Y 5| Ascending T Selection - F =1 New > Totals

Sign in

ab P
,O bac Replace [ iy (Detai) MR
— ER) Copy %! Descending T Advanced - H Save ¥ Spelling 3 GoTo~
View  Paste Filter efres ind BIU A~ O~
- ' Format Painter 5o Remove Sort 'Y ToggleFilter  ay. X Delete ~ ] More~ [3 select~ s £
Views Clipboard 5 Sort & Filter Records Find Text Formatting = ~
N\
- Asset List Tablet x
All Access Obje... @ «
D -| FirstName - [ LastName -| Salary - [clicktoAdd -
Search. p -
i 1 James Maina 4500

Tables & [« :
= | 2 Ruth Mwai 34499

Assets * 0
B contacts
ER Fiters
B settings
= Tablet
Queries %
B Assets Extended
EF Assets Retired
EP Contacts Extended
Forms P
Asset Details
Asset List
Contact Assets Datasheet ..
Contact Details LI

Contact List
Filter Details

Welcome

Reports P
All Assets

Asset Details

Asséts by Category ~ ||| Record: M 43
Datasheet View

H O Type here to search

5.6  Creating Database Form

v+ | T NoFilter | [Search
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Creating forms for your database can make
entering data more convenient. When you create
a form, you can design it in a way that works with
your database and that makes sense to you.

Step 1: Select desired Table

Step 2: Click Create

Step 3: Click Form

Step 4: Form will be Created and opened in Layout
view

Step 5: Click Save from Quick Access Toolbar. Type
desired name
Step 6: Click Ok.

loa] ] Trepomwina L] o5Modue

Docurments\Databasel.accdb (Access 2007 -

2016 file format) - Access

|| s B e | o o (T remee, e 1 s hrocie

P - izard Design Design Report " isual Basic
Templates Tables s Reports Macros & Code ~
All Access Obje... ® « Bia ] =

- 5 u ~ | FirstName | Create a form with no controls or Slick to Add -

o 1 James for
= A E‘ 2 Ruth waT 34459
3 Susan Faith 2350

o * (New) |

=]

EA settings

=

a; a

L

Re; a

tegory ~ | [Recora: 14« » | B o Futer | [Search ]
Data. B,

L ShapeFill -
L# Shape Outline

E =2 QR

Signin

T Select Al BEI U A . === § 9 » <3y Bsckground Altemate Quick Change Conditional _
b L - Image~ RowColor= Styles - Shape~ Formatting = Shape Effects
Selection Font Number Background Control Formatting ~
H | Table x
All Access Obje... @ « : : x
. e s v s s 7 s [q field List
. | € Form Header b [F showalltables
Tables a [« Save As ? b
E heset Il H s Fields available for this view:
ssets
Form Name: D
B contadts | rable1 Firsthame
EH Fiters LastName
5al
EA settings 22
T3 Tablet
Queries P

CF Assets Extended

EF Assets Retired

B Contadts Extended
Forms %

Asset Details

¥ Form Footer

Asset List
Contact Assets Datasheet ...
Contact Details

Contact List

Filter Details

Welcome

Reports %
All Assets

Asset Details 2

(4] ]

Assets by Category ~

Design View

O Type here to search

Adding additional Fields to a Form
When you use the FOFm command on an existing
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table, all of the fields from the table are included in
the form. However, if you later add additional fields
to the table, these fields will not automatically
show up in existing forms. In situations like this, you
can add additional fields to a form.

To Add a Field to a Form

Step 1: Click Design

Step 2: Locate the Tools group on the
right side of the Ribbon.

Step 3: Click the Add Existing
Fields command.

Design Arrange Format

1TEE W] )

Controls

UL
B

Adding Fields to Blank Form
Step 1: Click Create

Step 2: Click Form

Step 3: Click Blank Form

Step 4: Follow the above procedures already
discussed

Home Create External Data
E== ~sERN I sEsl ==

Table Table SharePoint Query Query
Design  Lists ~ Wizard Design

Tables Queries

ry

Insert [, Date and Time
Image

Database Tools

To add a Field from a different
Table

You can also add fields from different
tables in your database to the form.
From the Field List pane, click Show
All Tables.

Click the plus sign + next to the table that
contains the field you want to add, then
double-click the desired field. The new field
will be added.

5.7 Adding Design Controls

Design controls set restrictions on the fields
in your forms. This helps you better control how the
data is entered into your forms, which in turn helps
keep the database consistent.

Olenna Mason

E 1=

Add Existing Property
Fields % Sheet

Tools ~

SLogo

[ Title

Header / Footer

Design

D < Form Wizard

Na\ngatlon =
Form Form  Blank
Design Form More Forms ~

Forms

Arrang

Combo boxes

A combo box is a drop-down list you can use in
your form in place of a field. Combo boxes limit the
information users can enter by forcing them to select
only the options you have specified.

Combo boxes are useful for fields that have a limited
number of possible valid responses. For instance,
you might use a combo box to make sure people only
enter a valid U.S. state while entering an address, or
that they only choose products that already exist in
your database while placing an order.

To Create a Combo box
1. In Form Layout view, select
the Design tab, then locate
the Controls group.
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2. Select the Combo
BoXx command, which looks like
a drop-down list.

Design Arrange Format

B [ | I=1E3

v

il

U“-H.L./

e

— [ | Insert

Controls

3. Select the desired location for the
combo box. A line will appear to
indicate the location where your
combo box will be created.

4. 'The Combo Box
Wizard dialog box will appear.
Select I will type in the
values that I want, then
click Next.

Image

Combo Box Wizard

This wizard creates a combo box, which displays a list of values you
can choose from. How do you want your combo box to get its
values?

I want the combo box to get the values from another table or

query.

I will type in the values that I want.

combo box.

Find a record on my form based on the value I selected in my

Cancel ‘ ‘ = Back ‘| Next > | ‘ Finish

5. Type the choices you want to
appear in your drop-down list.
Each choice should be on its own
TOW.

6. If necessary, resize the column
so all of your text is visible. Once
you are satisfied with your list,
click Next.

7. Select Store that value
in this field,

the drop-down arrow
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and select the field where you want
selections from your combo box
to be recorded. After making your
selection, click Next.

Enter the label—or name—
that will appear next to your
combo box. Generally, it's a good
idea to use the name of the field
you chose in the previous step.
Click Finish. Your combo box
will appear on the form. If
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you created your combo box
to replace an existing field, you
should delete the first field. In
our example, you might notice
that we now have two fields with
the same name. These two fields
send information to the same
place, so we don>t need them both.
Well delete the one without the
combo box.

5.8  Creating Database Query

Step 1: Click Create

Step 2: Click Query Wizard

Step 3: Double click Table to base query on

Step 4: Click Close to close that dialog window

Step 5: Double click on the fields to be used in the
query

Step 6: Under Sort row, click on the cell for the
column to base sorting on and select sort method
Step 7: Under Criteria, select the cell for the column
to base criteria. Type desired criteria

Step 8: Click Run Query

Step 9: Save Query with suitable name

H e

File Home Create External Data Database Tools

sqQL | %-g @ +|| 5,' % () Union @ &= InsertRows " Insert Columns z rr.i?] [&=] Property Sheet

O ES50 (3 Pass-Through 2% DeleteRows X Delete Columns B Table Names
View Run  Select Make Append Update Crosstab Delete Sh

ow Totals Parameters
- Table £ Data Definition  Tapje < Builder T3 Return: | Al -

Results Query Type Query Setup Show/Hide A

All Access Obje... @ « |7 Qe *

Search..

Tables E
B asset Show Table T X
ssets

Sign in

I+ o
»

E contacts Tables Queries Both

= R

Contacts
EH settings Filters

3 Tabler Evik o
Queries E
Assets Exdtended

Assets Retired

Contacts Extended
Forms ES

Asset Details El:‘ m

Asset List

Contact Assets Datasheet ... Field:
[ Table:
Contact Details Sort:
O

Show:
Criteria:
Filter Details or

Contact List

Student Data Entry Form

o e e e e e I

Welcome

Reports %
All Assets

m}
T T T T T T T T T T

O

m}

m}

m}

Asset Details -
Ready

0 Type here to search
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£ Data Definition

&= Insert Rows
3% Delete Rows

N\ Builder

+ Insert Columns =
= &
Show
Table

| B3+ #1 &

% Delete Columns z
Select Make Append Update Crosstab Delete

Totals Parameters
I Return: | Al -

Query Setup

Run

View
© Table
Results

Query Type

= auent (3 Tame1"|ﬂ Query2 ',
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Sign in

[Z] Property Sheet
xz

£ Table Names

Showy/Hide ~

All Access Obje... @ «
Search..
Tables ES

Assets

Tablel

IO

%o
FirstName
LastName
Salary

Contacts
Filters

Settings

BB OE E

Tablel

o

ueries ES
Assets Extended
Assets Retired

iy Ly gy

Contacts Extended
Forms 3
EE sset Details

K1l

Asset List

Field:
Table:

Sort:
Show: =] =l

Criteria:
Filter Details ar

FirstName
Tablel

Lastiame
Table1

salary
Tablel
Ascending

<5000

Contact Assets Datasheet ...

Contact Details

Contact List

Student Data Entry Form

Welcome

7
°
g
a
@
»

Al Assets

Asset Details -
Ready

H O Type here to search

Bxternal Data Databa:
= 36 Cut

BB Coy
Paste = 7

2] Ascending Y7 Selection~
Filter ?L Descending 1] Advanced ~
% Remove Sort 'Y Toggle Filter
Sort & Fitter
= quent (2 rabm‘l'—: Query2

3 Totals
> Spelling
3 More -

= New
H save

Refresh -

All- 7< Delete -

Records.

= GoTo-
Find
[z Select~

Find

* Format Painter EREAL

Views Clipboard =

All Access Obje... @ «

b,
,O 8 Replace  [caiipn Detail) ~ [ -

A -

Sign in

o -

Text Formatting ® ~

FirstName ~ LastName - Salary -
2330

Susan Faith
Karis 3000

Henry
James
* o

searcn.
Tables ~
B sset

H contaas

EH Fiters

A settings

5=: e

Queries EY
Assets tended

Assets Retired

IOk

Save As ? X

Maina 4500 Query Name:

|salary less than 5000] ]

T |

Contacts Extended

]

Forms ES
Asset Details

Asset List

Contact Assets Datasheet ..
Contact Details

Contact List

Filter Details

Student Data Entry Form

Welcame

Asset Details -
Ready

Record: 4

» v [ B o Filter | [Search

QO Type here to search o

5.9 Creating Report

Step 1: Click Create

Step 2: Click Report Wizard

Step 3: Select a table or query, double-click each field
in Available Fields you want to add it to the
report, and select Next.

Step 4: Double-click the field you want to group by
and select Next.

Step 5: Complete the rest of the wizard screens and
select Finish.
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format) - Ac

T = R Form Wizard o) WS = £ Module
El=AnllEEE =R = ) [ Reonwe L]
"’—"’ SN e B Navigation ~ o ! Class Module
Application  Table Table SharePoint Query Query Form Form Blank — Report Report Blank [=] | poic Macro * >
Pa ign Lists~  Wizard Design Design  Forrf

Templates Tabes Queries Fol
All Access Obje... @ «
Search.

Tables ®

R Assets TablesfQueries

Report Wizard

Wihich fields do you want on your report?

You can choose from more than one table or query.

DA

B contacts [Table; Table 1
B Fitters
B settings

=
£ Tanier
>

Avaiable Fields: Selected Fields:

Queries 3
B Assets Exended

@ Assets Retired

@& Contacts Extendea

B3 salary less than 5000

Forms N z > ] |
Asset et

Asset List m
EE contact Assets Datasheet ...

Contact Details

Contact List

Filter Details

salaryless than 5000
Student Data Entry Form

Welcome

Report: A
Report Wizard

ﬂ QO Type here to search

Databas - Users\Prof. Daltor

AE M RE EEOZme = ] [ G L] e

Application  Table Table SharePoint Query Query Form Form Blank — Macro -

ar Design  Lists~  Wizard Design Design Forf o e
Templates Tables Queries Fo -~
All Access Obje... ® « Do you want t add any grouaing
Search.
Tables =
B assets
EA contacts
EA Fiters
EH settings
2 Tablen
Queries =
3 Assets Extended

Sign in

Report Report Blank

D, Firstiame, Lasthiame, Salary

Dl

S assets Retired

B contacts Extended

S salary fess than s000
Forms N i S cnca ||
Asset Details

<tk [ mext> || Enisn

Asset List -
Contact Assets Datasheet .
Contact Details

Contact List

Filter Details

salary less than 5000

Student Data Entry Farm

Welcome

Report:
Report Wizard

ﬂ QO Type here to search o

Create External Data Database ell me what you wa do Sign in

@ @ Dm ,@@ = % l:lg‘gpmmwmd *| @ D 5L Report Wizard D"J{Mudu\e

Navigation - = 2! Class Module

Application  Table Table SharePoint Query Query Form Form Blank Report Report Blank [=]) b Macro .
Parts ~ Design Lists~  Wizard Design Design Forrf Report Wizard
Templates Tables Queries Foi | ~
. What sort order do you want for your records?
All Access Obje... @ «
You can sort records by up to four fields, in either
Search. L ascending or descending order.
Tables 2 [ e
B oassets : I | ==
o === |:
EA Filters

EA settings
= Tablet
Queries EY

B Assets Extended

Assets Retired

Contacts Extended

salary less than 5000

. N Cancel [ <mack [ mewt> || mmeh
orms S

Asset Details
Asset List

Contact Assets Datasheet ...

Contact Details
Contact List
Filter Details

salary less than 5000

Student Data Entry Form
Welcome

Report Wizard

O Type here to search

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE



DIGITAL LITERACY

% @ Dm @@ P % D@Form\mmrd j @ D 5] Report Wiard £ Module

Mavigation ~ %! Class Module
Application  Table Table SharePoint Query Query Form Form Blank — Report Report Blank [=] Macro * 2

All Access Obje... @ « How would you like to lay out your report?
Search..

Tables &
B Assets

EA contads

B Fitters

B Settings

A Tablet

Queries 3

Layout Crientation

] o

) Columnar @Bortrait
@ifatii]\a? OlLendsczpe

) dustificd 5

7

Assets Extended ] Adjust the field width so al fields fit on
Assets Retired a page.

Contadts Extended

salary less than 5000
Forms N Cncd || <Bak | wext> || Enen

Asset Details
Asset List =

Contact Assets Datasheet ..
Contact Details

Contact List

Filter Details
salary less than 5000
Student Data Entry Form
Welcome

Report: a =
Report Wizard

H 0 Type here to search

5.10 Learning Activities

Identify some statistical information from your
organization. Using the information for the
following tasks:

Required:
1. Open a database application, and identify
fields and records
2. Based on organizational statistical data:
(i) Create a Database Table
(ii) Create a Database Form
(iii) Add 3 more fields in the Table. One of
the field should be a kind of combo box
(iv) Modify Your Form to include the added
Fields
(v) Create three different types of queries
based on your Database Table
(vi) Createa Report based on your Database
Table

5.11 Self-Assessment Questions and
Activities

1. Identify and describe the various parts of
table

2. Differentiate between a field and a record

3. Why do we need to store data in a database?
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6.0 USING POWERPOINT PRESENTATION 6.3 Overview of PowerPoint Presentation
6.1 Specific Learning Outcomes Microsoft PowerPoint is a graphical presentation
software package. The package is used for presenting
At the end of the topic, the trainee should be able to: materials through the use of multimedia that can
i. Identify the roles of presentation help to improve the audience’s focus.
software’s in an organization
ii. Create a presentation 6.4 Creating a New Presentation
iii. Formatting a presentation
iv. Running the presentation. Step 1: Click File
Step 2: Click New
6.2  Introduction Step3:DoubleclickonBlank Presentation
Step 4: A new presentation window opens
This topic introduces the students to the art of Step 5: Type in details for the Title slide

presenting materials through the use of multimedia
that can help to improve the audience’s focus.
PowerPoints allows the use of images, audio, and

video in order to have a greater visual impact. The Open
topic covers, introduction to the role of PowerPoint, o
. L . . . Recent Yesterday
creatlpg .new presen.tz'itlon,‘ adding, cqpymg, pasting, | Craprea
magnifying, and editing slides; applying themes and & oncorive Becuments
. . . P - chapter3 o
background to a presentation; inserting, modifying - ) Sl
. . . . . This PC :
clip Art/Pictures/shapes/objects; inserting, = This Week
. . . N chapter 2
updating, formatting chart; formatting text, bullets + Addapace - Aty
and numbering; slide transition effects and timing; I gF] Selecton
animation effects; slide show, change slide setup, | Sobee’
printing and running slide show; Navigate through e Older
slides during show. Emphasis will be on creating . | Obiect Ori
ptions Ciw Userss P
different slides for different type of audiences and ) Weekar
Ci» Users= P
organization. it
o) i
] 5
E\,‘ﬁ Graphs
O Type here to search o) gi | -

Search for online templates and themes o

Suggested searches:  Presentations Themes Education Charts Diagrams  Business  Infographics

- - =

Blank Presentation Urban monochrome: Welcome to PowerPoint Bring your presentations to life... Gallery

WooD TYPE. Quotable i
Berlin

Parcel Wood Type Ton Boardroom Quotable

*! DIVIDEND - = O
| CIRCUIT Frame fe—
ircuit i @ janic

0

Title Lorem
Ipsum

El O Type here to search
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S Cut [E] Layout - A x| iz .= |&=3=| 1z UfiTetDirection SOoOl Do (T 23 Shape Fill P Find
e =R =] = y
0 B Capy 2] Reset [5] Align Text AlLLod G- 0 L Shape Outline - | 28 Replace -
Paste New ====|== Amange Quick

N M _pa | A ===== - .
2 e | gone jgemppe | D 2 I P aRmefac R ESSE(= B Converttosmartart - || 4 A€ 3 98 5750 LT Q9 Shope ifects - | 13 Select -

Clipboard [} Slides Font Paragraph Drawing Editing

Click to add title

Click to add subtitle

Slide 1 of 1

0z
H O Type here to search

6.5  Adding New Slides to a Presentation

= Notes Wl Comments B 855 BE T -—F———+ 7% [

Step 1: Right Click on the Current Slide (or
in the Home tab, go the Slides group and
click on New Slide

Step 2: Click on New Slide

Step 3: Type or Copy desired text in the slide

Presentatio

Signin S Share

£} Text Direction m} —y, r Shape Fill £ Find
= oook B [ 4
[5] Align Text ALl Lodn- -&” [# Shape Outline~ | % Replace ~
<] Alig p pl
~ Amange Quick
= ConverttoSmartArt~ || % Y\ € ) fr |77 Styles - @ Shape Effects = | [y Select -

Editing -~

Design  Transtions  Animations  SI

&D X% cut —j [ Layout - = ®lr
paste B Copy - oy D Reset

© e AV

=" @ Fammat Painter | grge. SSSection- | B I U Sax - Aa-| A

Clipboard 5 Slides Font Paragraph Drawing

1 |
% Cut

By Copy

iy Paste Options:
P

|

New Slide

Duplicate Slide
Delete Slide

Click to add title

Publish Slides

8l mi 5 o [

Check for Updates = -
. Click to add subtitle
Layout >
Reset Slide

Format Background..

Photo Alburn...

he 41 & 08 [

Hide Slide

Slide 10f1 [ = Motes W Comments E == B T -—b—+ 3% B

B 7w ) E

O Type here to search
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6.6 Running a Slide Show

Step 1: Click Slide Show

Step 2: In the Start Slide Show group choose either
from beginning, from current slide, broadcast show,
custom slide show.

- 3] - x

Signin £ Share

Insert Design Transitions. o Slide Show

S B B B LT Ll @D P i avom -
Fre

Use Timings

From Present CustomSlide  SetUp  Hide Rehearse Record Slide (i B
Beginning Current Slide  Online~  Show - Slide Show Slide  Timings ~ Show - [ Show Media Controls
Start Slide Show Set Up Monitars ~
[=]
1
e
) Click to add title e
— <
(R
< 1e]

= Notes Wl Comments B 5 B %= -— b+ 73% [

Slide20f2  [1Z

QO Type here to search 0

6.7 Presentation Views

There are many views like Normal View, Slide Sorter
View, Notes Pages and Reading View.

Normal View is the most common slide view.
By default, the presentation one is in normal view.
Normal view simultaneously displays the slide,
outline, and notes view in their own, allowing you
to see everything at once.

Click on View to access any of the view pane

- = X

Design Transitions Animations c R View Signin £} Share

= =& [ Ruler =) [ Color =1 H Arrange All [l

Eli=INSE e - LE = == ==
[ Gridlines &= Grayscale ) Cascade
Normal Outline Slide MNotes Reading Slide Handout Notes Notes Zoom Fitto New Switch Macros
Wiew | Sorter Page View | Master Master Master | || Guides Window mm Black and White | \yindow E53 Move Split  Windows -
Presentation Views Master Views Show ® Zoom Color/Grayscale Window Macros -~

1 Title =
00

Click to add title

= Click to add text

Click to add notes

sidezorz 2

QO Type here to search o
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Slide sorter view shows small versions of all
the slides (thumbnails) arranged in horizontal rows.
Thumbnails allow for slides to be easily deleted or
rearranged quickly.

= color =2 H Arange all

Tr: = A
Rub o |
e I I Grayscale T3 @ Cascade =

Notes Reading | Slide Handout Netes == Switch
e e i Black and White | i

Presentation Views Master Views Show

Guides o T Move Split  windoms~

Zoom Color/Grayscale Window

Title

side1of2 [

QO Type here to search a

Notes Pages sometime referred to as presenter
notes show a small version of the slide with an area
below for printed notes. Each slide is created on its
own notes page.

= - x

Signin £ Share

Animations

Transitions

Design

r‘ﬁ B arrange All

Bl =
[ ] Gridlines &= Grayscale | [ Cascade
Mormal Outline  Slide Slide Handout Notes Notes  Zoom  Fitto lew Switch | Macros
View Sorter | Page | View  Master Master Master L Guides Window |l Black and White  indow [ Move Split  Windows ~
Presentation Views Master Views. Show ) Zoom Color/Grayscale ‘Window Macros ~
Title
i i

Notes1or2 [

QO Type here to search

Reading View is used to deliver a presentation
to a person viewing it on a computer as opposed to
viewing it on a large screen. It allows a user to view
the presentation not a full-screen slide show view,
but in a window with simple controls that make a
presentation easy to view.
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Title

BBl O veerere o searen o B

6.8 Applying Themes and Background to a
Presentation

Step 1: Click Design tab
Step 2: Click More button in the Themes group
Step 3: Click the desired design

‘ ‘Aa

Click to add title

* Click to add text

Siaczorz m
Il © v nere o scaren @,

To Apply a Theme to Selected Slides
Step 1: Click Slides tab, located in the left pane of
the window

Step 2: Hold down the Control key and then click to
select the slides to apply the theme

Step 3: Choose Design tab

Step 4: Click More button in the Themes group

Step 5: Right click desired theme. A menu appears
Step 6: Click Apply to Selected Slides

Aa

nin S
= Aﬂ | EE E &
] Apply to All Slides Sld Fsmt
Backgroun

Themes Apply to Customize

m)

Add Gallery to Quick Access Toolbar

Click to add title

* Click to add text

4

»

£2

Slide2of2 [
ﬂ QO Type here to search O
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1

Click to add title

Click to add text

Sidezofz [2

QO Type nere 1o search

Changing Backgrounds

Step 1: Choose Design tab
Step 2: Click Background Styles
Step 3: Click the desired background

B - B = Bl - 3 e T - R
Signin & Share

i
Slide Format
Size~

File Home Insert Transitions Animations

View
e ] O
Variants Customize ~

Themes
7 Format Background |
Fine-tune the formatting for your
e background or hide design
elements from the current design.

Click to add title ¢

2
¥

= Motes B Comments B 58 B ¥ -—4F+——+ 73% [

Side2of2  [|2

O Type here to search

6.9  Copying and Pasting Slides from
Different Presentations

Step 1: Open at least two presentations

Step 2: Click Arrange All button from View tab
(Window group)

Step 3: Right click on the slide to be copied (in
the slides and Outline task pane of the original

presentation —source)
Step 4: Choose Copy from the short/cut context

menu
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Step 5: In the destination presentation, right click
in the desired location. Right click and choose Paste
and apply desired options

6.10 Saving a Presentation
Step 1: Click File
Step 2: Click Save or Save as

Step 3: Selected desired folder and provide filename
Step 4: Click Save

Info

Protect Presentation
» Control what types of changes people can make to th
Protect
Presentation -

B Inspect Presentation
@ Before publishing this fils, be aware that it contains:
Check for " Document properties and author's name
Issues - " Content that people with disabilities are unable tc
—‘j Manage Presentation
Q| Check in, check out, and recover unsaved changes.
Manage ¥ There are no unsaved changes.

Presentation ~

Account

Options

O Type here to search

Save As

@ OneDrive
L3 Thiskc
=
=)= Add aPlace
Browse
Account
Optians
QO Type here to search 0 =1 = -
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3 save s

€« v 4 > ThisPC > Desktop » WordStore v & | Search WordStore

>

|l - PowerPoint

o

Organize = New folder B @

= ThispC Name Datemodfied  Type

30 Objects Mo items match your search.
I Desktop

Documents

¥ Downloads

) Music

] Pictures

B videos

o Local Disk (€] v < >

Filename | Tite 7]

Saveastype: Powaraint Presentaion v

Authors. Prof, Daon Tags: Addatag
A Hide Folders Tools ~

6.11 Opening Existing Presentation

Step 1: Click File

Step 2: Click Open

Step 3: Select desired presentation file
Step 4: Click Open

©

Info

New

Protect Presentation
Open Cantrol what types of changes people can make to this presentatio
Protect

Save Presentation =

Save As

N Inspect Presentation
& ,

Print Before publishing this file, be aware that it contains:

Check for

" Document properties and author's name
Issues -

5
g " Content that peaple with disabilities are unable to read

Export

Close

—ul Manage Presentation
Q| Check in, check out, and recover unsaved changes.

Manage ] There are no unsaved changes.
Presentation -

Account

Options

o
[ |
]
I

QO Type here to search 0
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Open
(L) Recent

. OneDrive
El:l This PC
o= AddaPlace

Browse

uuuuu

= O Type here to search 0 E

rrrrrrrr [ | ApowepoinPrsentations .

s - [ |

g

6.12 Inserting Items in a Presentation

Inserting Clip Arts in a Presentation

Step 1: Click Insert

Step 2: Click Clip Art. In the Search for text box,
type keywords related to the clip art that you desire
Step 3: Click Go. A list of images appears in the
Results section

Step 4: Click desired image to insert

Inserting Clip Pictures in a
Presentation

Step 1: Click Insert

Step 2: Click Picture

Step 3: Choose pictures or locate folder where your
desired picture is located

Step 4: Under File Name locate the folder where
your desired picture is

Step 5: Click Insert

Inserting Shapes/Objects in a
Presentation
Step 1: Click Insert

Step 2: In the illustrations group, Click Shapes
Step 3: Select desired shape

Resizing Shapes/Objects in a
Presentation

Step 1: Select the shape to be resized

Step 2: Click and drag a handle until the shape
attains the desired size.

Inserting a Chart in a Presentation
Step 1: From the slides pane, select the slide to which
you want to add a chart

Step 2: Click Insert tab

Step 3: Click Chart

Step 4: Select the chart type from the displayed list
Step 5: From the gallery in the right of the dialog
box, select specific type

Step 6: Click OK

Step 7: Type your data into the Excel worksheet
Step 8: Click Close

Creating an Organization Chart

Step 1: Open a presentation

Step 2: Click Slides

Step 3: Click New Slide

Step 4: Select Title and Content

Step 5: In the center of the slide, from the content
icons, Click Insert Smart Graphic

Step 6: From the Categories list, select Hierarchy
Step 7: From the gallery, select Organization Chart
Step 8: Click Ok

6.13 Transition Effects and Slide Timings

Slide transition is a special visual effect that is used
to introduce a slide during a slide show

Slide timing refers to the length of time a slide
appears in the screen

Adding Transitions

Step 1: From the Transitions tab go to the Transition
to this Slide and then select Transition Gallery

Step 2: Change Duration in the Timing group

Step 3: Choose to add a sound to the transition,
clink on Sound

Step 4: Choose to apply this transition to all of your
presentations slides,

Step 5: Click Apply to all in the Timing group
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< Sound: [NoSound] - | Advance Slide

T - = @ B EB [ L gnmre e,

uf ade ust ipe eveal andom Bars. ape ncover = . -
Cut Fad Push Wip | RendomE Shap- v = options - | 2 Apply To Al [ After: |00:00.00 -

Preview Transition to This Slide Timing

m)

Click to add title o

stide20r2 (12

QO Type here to search

6.14 Printing a Presentation

Removing Transitions

Step 1: Select desired slide

Step 2: Click Transition

Step 3: Select None in the Transitions gallery

Step 1: Click File
Step 2: Click Print

Slide Timing

Step 1: Click Transition

Step 2: In the Timing group go to Advance Slide and
select After

Step 3: In the After-text box, select desired time
Slide Animation

Step 1: Select the slide to which you want to apply
desired animation

Step 2: Click Animation

Step 3: Select an animation from the Animation
gallery

Tt

R Click to add title @

stide2or2 (2

QO Type here to search
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6.15 Learning Activities

Open a computer and undertake the following
activities:

Required:
i. Create a presentation using information
from the department
ii. Insert objects and chart in the presentation
iii. Apply different slide designs
iv. Insert animation and effects to some of the
slides
v. Save presentation with any name of your
choice
vi. Change presentation timing
vii. Run presentation

6.16 Self-Assessment Questions and
Activities

1. What are the various parts of the
PowerPoint environment?

2. How can PowerPoint be used in a freight
and logistics organization?

3. What are the presentation etiquettes for
effective PowerPoint presentations?
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7.0 DESKTOP PUBLISHING
74 Specific Learning Outcomes

At the end of the topic, the trainee should be able to:
i. Describe the role of desktop publishing
ii. Create different types of desktop
publishing documents
iii. Formatting desktop
documents
iv. Importing and exporting text
v. Object linking and embedding

publishing

7.2 Introduction

This topic introduces the student to the technique
of creating document using desktop publishers. The
topic covers: introduction to the role of desktop
publishing; Elements of attractive page layout,
colour, and design; creating simple drawings,
announcements and magazine covers multi-page
documents such as menus, newsletters, tri-fold
brochures, a business proposal. Students should
be able to produce different types of professional
documents.

7.3 Desk Top Publishing with MS
Publisher

While both Word and Publisher can create
documents that seem fairly similar at first glance, the
underlying structure of each is markedly different.

o Word treats a document as a continuous
flow of characters, which have to be
formatted “in-line”.

« Publisher is “object-oriented”,
meaning that it treats a document as a
collection of separate and distinct objects
which can be moved, edited, or deleted
completely independent of any other
objects in the document. Images can also be
placed outside of the document page area to
be used as a parking space.

7-4 Starting Microsoft Publisher

Click on the Windows start button and search for
MS publisher

@ 1, Click on Windows Start Button

3

IL—" Getting Started
.u‘ Connect to a Projector
EY calculator

I sticky Notes

& soopingTo

a

. Scroll down until you see N

click on it, and find

,;ﬁ Paint
il XPS Viewer
& Windows Fox and Sean

% Remote Desktop Connection

I@ Microsoft Word 2010

> AllPrograms

Search prdgrams and files

[ 2 . Next, click on

Office €

[A] Microsoft Access 2010
(&] Microsofe Excel 2010
(] Pticrosoft InfaPath Designer 2010
(] Microsott InfoPath Filler 2010
[M] Microsoft OneNote 2010
i3] Microsoft Outicok 2010
[B] Microsoft PowerPoint 2010

A Publisher 2010
] ™ SharePoint
(W] Microsatt Word 2010
4 Microsoft Office 2010 Tools
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7.5 Publisher Layout

Publisher opens to a Page Design Screen. This page
is where you can locate various template designs for
a multitude of business and personal needs. You
can start with a blank document or work from a pre-
designed template.

Templates - Publisher has many pre-formatted
templates, which allow you to get your
publication completed with minimal formatting
work.  We are going to start with a flyer
template.

You will notice on a template that there are several
layers - layers can consist of images, background
colours, or text boxes. Click on different parts of
the template to get familiar with the different layers.
Clicking and dragging these objects will move them.
If you move something by accident, dont worry,
there is an undo button on the Quick Access Toolbar
at the top of the screen. The keyboard shortcut to
Undo is Ctrl+Z.

« Creating blank publications - If you don’t
want to use a template or cant find a
template that suits your needs, you can
create a blank publication. If you
create a publication from scratch or decide
to heavily modify a template, there are three
components of page layout you’ll have to
consider.

« Size - Some publications,
like flyers, can be large or small.
However, you probably don’t want
a brochure to be giant.

Home  Insert  PageDesign  Mailings  Review  View

I save
Available Templates
& save s
25 open Installed and Online Templates E|
B Close 2t Home

Info

Recent %
Lt
)
Blank 8.5 x 11" Blank 11 x 85" More Blank
Print Page Sizes

Most Popular

Orientation - Do you
want your publication to be
in landscape orientation (wider
than  tall) or  portrait
orientation (taller than wide)?
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Home Insert Page Design

Ay

Jptions | Margins |Orientation| Size

ate Iy
- Portrait
[
Landscape

[

« Margins - Margins are areas
of blank space that line the
edges of a printed document.

Home Insert Page Design

EYN

Change Options | |Margins| Orientation Size

-

Template

Template Iége Setup

Margins

Select the margin sizes for the
entire document or the current
section.

6 Press F1 for more help.

| [l _|
7.6 Tabs/Groups

The ribbon is the menu that runs across the top
of your screen. Each tab contains a set of groups
with commands. Groups are collections of related
command buttons. Clicking on different tabs will
change the ribbon.

Some tabs, like Text Box Tools or Picture Tools, may
appear only when you're working with certain items
like text boxes or images.
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E_Il

E

i Home Insert Page Design lml Review Acrobat
= |

Text Box Tools

QBr'u; ard = [f] Fxy

ille
= ! —
EHC A &2
ncag | . i E=== 9 — 37| o Gsenadgow v B
. - " . g aw rap
g | B T 0 x x A |25 LR | Tet Box 1" | Text- |2 Align Sh| -
I | I /{ W | Paragraph Objects Arran

—

Each tab is
divided into
groups.

Click ona tab
to see more
commands.

7.7 Viewing Tools

Publisher offers a group of viewing tools to help
you control the layout of your text, images, and
objects on the page. These viewing tools are for
your editing purposes only. They can be turned on
and off and will not appear in your printed
publication.
« To access and choose viewing

tools, select the View tab, then

locate the Show group. Click the

check boxes of the various view

options to turn them on and off.

Page Design Review

Mailings

Boundaries Rulers Graphics Mar
Guides Page Mavigation Baselines

Scratch Area

[FShow |

Publication viewing tools include:
. Rulers

You can use the rulers to the left
and top of your publication to
help you line up text, images, and
other objects and get a clearer
idea of exactly where those objects
will appear on the printed page.
When you select an object in your
publication, a white space will
appear on the rulers to show the
object’s location.

‘ Fields

Some groups will
have an arrow that
you can click for
more commands.

Special tools tabs will
appear when you click

on certain items within
your publication.

Baselines

Baselines are evenly spaced
horizontal lines you can use to
line up text. You'll learn about
automatically aligning text to
your baselines in the Working
with Text lesson.

_email: martin@greenlightstuc

. web:greenlightstud

phone: 321-¢

Boundaries

Boundaries are dark blue dashed
borders that appear around
your objects. Viewing object
boundaries can be useful when
you're aligning objects or
wrapping text.
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. Guides
Guides are thin lines that help you
align various objects. There are
two types of guides:

. Margin guides, which are
blue lines that mark the edges,
or margins, of the printable
area on each page of your
publication. Margin guides are
automatically created when you
set your page margins.

Blue guides
indicate page and
area margins.

. Customizable guides,
which are green lines you can add
anywhere on your publication.

Guides can be useful
for lining objects up...

Texlahoma High
6400 SixMile Road,
Skellytown, TX 73080
Phane: 313-655-5285

Fax: 919-555-5286

...as well as for
T T T . 3 marking areas where
I you plan to fold the

printed publication.

Submit_YoufJPi‘ctp;@:s_ or

To add green guides:
1. Click cither the horizontal or
vertical ruler.
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reate Vertical Guide.
Shift+Drag to mowve vertical ruler

2. Drag your mouse to your
publication, and release to add
the guide in the desired location.

3. Your guide will be placed. You can
move it at any time by clicking and
dragging it.

7.8 Backstage View

In Publisher 2010, options for saving, printing,
and creating publications are located
in Backstage view. It is similar to the Office
Button Menu from Publisher 2007 or the File
Menu from earlier versions of Publisher. However,
unlike those menus, it is a full-page view, which
makes it easier to work with.

o To access Backstage view, click
the File tab.
Review the interactive options below to learn about
the different things you can do in Backstage view.
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7.9 Changing or Adding a Template
If you create a publication from a template and later 3. The Change Template dialog
decide the chosen template doesn’t quite suit your box will appear. Select a template to
needs, you can always change it. You can also preview it in the Preview pane.
apply templates to publications that were originally 4. Modify template options as desired.
created from blank pages. 5. When you are satisfied with the new
template, click OK.
To apply a new template to an existing publication: 6. A dialog box will appear asking you
1. On the Ribbon, select the Page how you wish to use the template.
Design  tab, then locate You can either:
the Template group. o Apply the template to
2. Click the Change the current publication
Template command. o Create a new publication
that includes the text and
images you have added
7. Click OK.
Fage Design 8. The new template will be applied to

h #j IE your publication.

Change Options | Margins Orientation  Size
Template - hd

Template Page Setup

Change Template

Select a new template for the
publication, and move your
existing content to the new
publication.

You can choose to replace the
current publication or create a new
ane,

| =l
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7.10  Adding, rearranging, and deleting
pages

If youre creating a newsletter or another
type of publication with multiple pages, you
might find the Page Navigation pane useful.
The Page Navigation pane gives you a way to view
and scroll through the pages in your publication.
It also includes features that let you add, move,
and delete pages.

1. To open the Page
Navigation pane, click
the View tab on the Ribbon,
then locate the Show group.
Select the Page Navigation
check box.

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE

Home Insert Page Design Mailings ] View [

Boundaries Rulers

Guides Page Navigation
MNormal| Master | Single [Two-Page
Page Fields [W%scrateh Area
Views Layout Show
Page Navigation

Show the Page Mavigation pane,
which displays an image of each
page in the publication.

The Page
Mavigation
pane

. To add a new page:

1. Inthe Page Navigation pane, right-
click any page, then select Insert
Page.
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Insert Page...
1 Insert Dupligate[%age

Delete
Move...

Eename...

Page Numbers k 2 3

Master Pages L4

View Two-Page Spread
El

2. The Insert Page dialog box
will appear. Specify the number
of pages to insert and the location
where you wish to insert them.

3. Choose what will appear on
the new pages. By default, the
pages will be blank, but you

can also choose to create pages 2. Click and drag the page to its
that include one text box or new location, then release the
pages that are duplicates of an mouse.
existing page. 3. The new page order will be applied.
4. Click OK.
5. The new page or pages will be + To delete a page
inserted. 1. Inthe Page Navigation pane, right-
click the page you wish to delete,
Depending on the template you're using, when you then select Delete in the list that
add a new page you may see a dialog box with page appears.
layout options. 2. If the page is part of a two-

page spread, Publisher will ask
+ To move a page: if you wish to delete one or both

1. InthePage Nav‘igation pane, locate pages. Make your selection, then
the page you wish to move. click OK.
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Page v m gE
Delete f i
il | @ Both pages move resize  resize resize
| | @ LeR page ariy obiect  opject  vertically horizontally
(71 Right page only
. Insert a new text box
[ OK DP—] [ Cancel 1. Insert tab and click Draw Text Box
3. 'The page will be deleted. ign Mafings Review Wigw Format Format
Pa B0 % & =
7.11 TeXt Boxes Shapes Pcture F!q! Dﬁs Borders & Advertizements Diraw Busin
* Paceholder | Parts ~ * Accents = L4 Text Box Informal
trations Building Blocks F
A text box is a dedicated area to insert text. Most
templates automatically have text box areas 2. Move your cursor to the document
predesigned for your convenience. You can click and notice your cursor has
inside the text box and edit as needed. changed to a crosshair icon

Click and drag your cursor to form a
text box. Once you release the left mouse
B button, your text box will be formed. You

A ‘wf can resize and move the box as needed.
‘ + Connecttextboxes foroverflow
text
Come to our You may find yourself in a situation where your
Family Reunion! DEfAUERE boxesyed text will not fit one given text box. You can link text
g can edit, delete or add . .

e P——— boxes so overflow text continues in a separate place.

should bring something and whether to RSVP.

Where: Joha and Mries House
234 Main Street

To connect to a new text box:

1. Select your text box.

2. Click the Text Box Tools
Format tab, then locate
the Linking group.

3. Click the Create
Link command.

RSVP. lohnor

Resize a text box:

1. Select the text box by clicking on the
perimeter or inside. You should see the box
highlight with a border.

2. On the border you should see little bubbles
on the corners and middle of the sides.
When you hover your mouse over these
bubbles, you will see your cursor change to
a two-pointed arrow.

3. Click and drag your mouse on these bubbles

to resize the text box. This takes some

practice and finesse so don’t get frustrated if
it doesn’t work for you right away.
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r——
w' Text Box Tools

Page Design Mailings Review View Format Farmat
Cambria - 0 - AW % E = =§ E' """ Break
= = = Next

B 7 U x, X’ Aa~ | &V~ é- lglglgcmumns Margins

- -

| Font Fa Alignment nking
Create Link Ll

Link this text box to another one
5o that text flows between them.

The mouse cursor will change to
show that you are ready to link.
Click on an empty text box to link
to it

Text will flow from the current text
box to the linked one.

Jake Tarly with Ll Lady Whiskers

According to Jake Tarly. he'sjust a man like =
no other. He would never call himself a hero.
Chances are, though, if a certain cat could]

4. 'The Link icon will appear in place
of your cursor. Click the spot on
your publication where you would
like to add the linked text box.

5. 'The text box will be added. Resize
it as necessary.

6. Continue typing your text. Any
text that overflows from the
original text box will now appear
in the connected box.

The new text box will appear with your previously
unseen text. You may need to resize the text box as
necessary.

« Wrapping text
If you place a text box near another text box or
object, you may notice them overlapping or not
appear exactly the way you want. Changing the
wrap text settings may fix this problem.
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To wrap text around an object, such as a picture:
1. Select the object, then click
the Format tab that appears on
the Ribbon.
2. Locate the Arrange group, then
click the Wrap Text drop-
down command.

Format

==. | q w A.=§= | | === @ % Il Bring Forward = E Group
— — [ send Backward ~ II™] Unaroup
- = Stz.rl Draw Picture Table Shapes Wrap
- Text Box n_-xt = |= Align - 2 Rotate ~
u | Styles Objects Arrange
L PR R BT WTEP T'EIt L P T | | 1 | 1 1 |

Change the way text wraps around
objects,

To configure an object so that it
moves along with the text around
it, select In Line with Text.

3. Select the desired wrap option. The
text will adjust based on the option
you have selected.

[

|E =@ A

L1 11 E
f  Picture Table 5hapes | Wrap | _
o - - | Text= | |2
—| ¥ Mone =
E Square an

e Tight

Top and Bottom

)

|
H R B E R

Through

In Line with Text

Edit Wrap Points
More Layout Options...

4. If necessary, reposition the object
until the text wraps correctly.
If you can't get your text to wrap the way you wish,
click the Wrap Text command and select More
Layout Options from the menu. You can make
more precise changes in the Advanced Layout dialog
box that appears.
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. Modifying text boxes
The Text Fit options allow you to format text
boxes that automatically adjust font or
text box size to get a good fit. There are four text fit
options you can apply to any text box:
« Best Fit, which makes the text
larger or smaller to fit the text box
- Shrink Text on Overflow,
which automatically shrinks the
font size when the text box has no
room for additional text
. Grow Text Box to Fit,
which automatically enlarges the
text box based on text size and
length
. Do not Autofit, which makes
no automatic changes to the text
or text box size; this is the default
option

To modify text fit, select the text box, then
click the Text Fit drop-down command
in the Text group of the Text Box
Tools Tab. Select the desired option.

7.12  Hyphenation

Microsoft Publisher automatically cuts words off
with hyphens in order to fit text into a confined
space. You can control how often the program
hyphenates words by changing the hyphenation
settings.

a9 %
File Home Insert

43y - - Arial
2 mu be =
T Text Hyphenation B F O x, x' | Ky | A~ = _, Columns Margins | Create
3y Sane L%  Aaziss T e ek

Ted 0 Fant 5 Alignmenit L

Page Design Maings Review View

. To remove all hyphens

1. Highlight the text

2. Click on Text Box Tools Format tab,
then Hyphenation

3. Uncheck the box next to Automatically

hyphenate this story, then OK

. Changing the
Zone

1. Increasing the Hyphenation Zone will
create fewer hyphens, but the text may
appear more uneven on the right-side.

2. Decreasing the Hyphenation Zone will
break up your text with more hyphens.
More hyphenated words will make the right
edge of the text appear more even.

Hyphenation

7.143  Formatting Text

Refers to changing the appearance of text. Select the
Home Tab, Font group and then Font style and size.
Alternatively, when you hold your mouse pointer
over each font, you can preview what that change
will look like in your document. The changes aren't
permanent until you click your selection!

Grow/Shrink font ‘

/

|A‘A' &
B J U x, x Aa~ |- | A~

Carbel |38 ~

Font [ l

Other formatting features include numbering,
alignment and paragraph settings.
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Line & Paragraph

Spacing

7.14 Inserting Pictures and Clip Art

In Publisher, the components of any publication
are called objects. You've already worked
with text boxes, which are one type of object.
Publisher offers decorative objects as well,
including shapes and Building Blocks.

In this lesson, you'll learn how to create and
modify shapes and Building Blocks.
You'll also learn how to align, group,
and arrange objects of all types.
1. Select the Insert tab, then locate
the Illustrations group.
2. Click the Shapes drop-down
command.

Page Design

Mailings

.......

@t Elgl =
F H b g2 P =
Page (Catalog  Table Picture Clip Shapes  Picture
= Pages " Art - Placeholder

Pages Tables Illustrations

Shapes S )

Insert ready-made shapes, such as
rectangles and circles, arrows,

lines, flowchart symbols, and
callouts.

9 Press F1 for more help.

3. Select a shape from the drop-down
menu.
4. Click and drag the mouse until the
shape is the desired size.
5. Release the mouse button. The
shape will be added to your
publication.
To add a picture to your publication, you can either
insert an image you have saved on your computer
or choose one from Publisher’s large selection
of Clip Art. Once you've added images, you can
then edit them as you wish.
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.« To resize a shape:
1. Select the shape.
Click and drag one of the sizing
handles on the corners and sides of the
text box until it is the desired size. You can:
o Drag the top or bottom
sizing handles to modify
shape height
o Drag the side handles to
modify shape width
o Drag the corner handles to
modify height and width at the

same time

I

o T 2

Vo~
I %
LA I

3 r

LF

3. To rotate the shape, click and drag
the green handle.

4. Some shapes also have one or
more yellow handles that
can be used to modify the shape.
For example, with this sun shape
you can adjust the diameter of the
center circle and the length of the
points.

Ifyouhold down the shiftkeywhileresizinga shape,
the shape will keep its proportions instead of
getting stretched out. For instance, if you hold down
the shift key while you resize a square, the final
shape will remain a perfect square with four equal
sides.

. Modifying shapes
To change to a different shape:
1. Selecttheshape, then click the Format tab
and locate the Shape Styles group.
2. ClicktheChange Shapedrop-
down command.
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3. A drop-down list will appear.
Select the desired shape.

Mailings Review View Format
3 shape Fill -
I E] D - | & shape Outline ~

- ’lﬁ) Change Shape *] :

[4]

Basic Shapes

Noov EEﬂBDDﬁO
lsl=]=]m @AL XN
IR N N

Block Arrows
T AR LRI T
€ dwnpD D Ll
N A

Flowchart
OO0 aly
CDCANKRB X6 AVED
Qg@o

Callouts

/ I 0 o %
AT AT R 10 AD AD dO

Stars and Banners

r B4 Yy @ 4 g S R TR
T SISV ]

[l

4. The shape will be changed.

« Change shape style:

1. Selecttheshape, then click the Formattab
and locate the Shape Styles group.

2. Click the More Shape
Styles drop-down arrow.

gk _

ilings Review View Format

Ly shape Fill - D
C] D D = el |
= Shadow

= Change Shape ~ | Effects ~
Shape Styles [F] | Shadow

More .|.I.|.|.|.I.|.|5.|.I.|.|.|.I.|

Choose a visual style for the shape

Calines *
(‘/— 5, \")
1 1
(,\— o —/o

et

A drop-down list of styles will appear.
Move your cursor over the styles to see
a live preview of the style in your
publication, then select the desired style.

4. 'The style will be applied to the

shape.

. Change the shape fill color:

1. Selecttheshape, thenclick the Format tab
and locate the Shape Styles group.

2. Click the Shape Fill drop-down
command.

3. A drop-down list of colors will appear.
Select the desired fill color from the list.
You can also choose No Fill to remove
the fill from your shape or More Fill
Colors to select a custom color.
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Crawing Tools
Review View Format
. | Salshape Fill -
@ [[j Scheme Colors ne
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' Standard Colors 19
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Mo Fill
L3 ] - |
E} More Fill Colors...
Z sample Fill Color
Picture...
E Gradient 3
Tewture »
Pattern...

4. The new fill color will be applied.

. Change the shape outline:

1. Selecttheshape, thenclick the Format tab
and locate the Shape Styles group.

2. Click the Shape Outline drop-down
command.

3. A drop-down list of options will appear.
Select the desired outline color from the
list. You can also choose No Outline to
remove the outline from vyour shape
or More Outline Colors to select a
custom color.

4. If desired, further modify your
shape  outline by changing the
outline’s weight (thickness) and whether
or not it is a dashed line.

_ i A _

lings Review View Format
- || |shape Qutline =

000 e

shapestyles N EE HHE L

|.|.I..2......I.||3||I‘i'I III
T .

Mo Qutline

&% Shape Fill =

=

More Outline Colars...

Weight ]

]
z Sample Line Color
wpt — [a]|=
¥ pt =
Hopt
1pt

1% pt
2% pt
3pt  ——

43; pt

5. 'The shape outline will be modified.

« Add a shadow:

1. Selecttheshape, then click the Formattab
and locate the Shadow Effects group.

2. Click the Shadow Effects drop-down
command.

3. A drop-down menu with a list of shadow
choices will appear. Move your mouse over
a shadow effect to see a live preview of it in
your publication.
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Drawing Tools

&3 Shape Fill - D mi ﬂ
| [ shape Outline + | &2 &, o

Format

S |

e Shadow 3-D
- @ChangeShape' | |Effects - D@ Effects
=T "
0 —
Ly
L @ Wl
™
Perspective Shadow
4 "

N o &

Additional Shadow Styles

sls]l=ls
00 @

iy Shadow Color 4

4. Click the desired shadow effect to
apply it to your shape.

You can select Shadow Options from the
drop-down menu and click the Color button to
select a different shadow color for your shape.

« Working with Building Blocks
Building Blocks are another type of object in
Publisher. They usually contain some combination
of text, shapes, and images, and theyre
meant to enhance the appearance of your
publication. Once you insert a Building Block, you
can moditfy it to suit your needs.

There are four types of Building Blocks Namely:
Page parts, calendars, Borders and Accents, and
advertisements
To insert a Building Block:

1. Select the Insert tab, then locate

the Building Blocks group.

2. Click one of the four Building
Block drop-down
commands.

Page Design Mailings Review View

18 ® = |28 8B

ure Clip Shapes  Picture Page Calendars Borders & Advertisements
Art < Placeholder | Paris - = Accents - <

Da’ Building Blocks fa

.......

Illustrations

Calendars 0 1 N YT Y

Insert a calendar of the current
- month aor next month,

For other dates, select More
Calendars. R O S e

3. A drop-down menu will appear
with Building Block styles and
options. Select the desired Building
Block.

4. The Building Block will be inserted.

5. If desired, modify the Building
Blocks text and formatting
until you are satisfied with its
appearance.

7.45  Arranging Objects

Publisher offers a number of tools to help
you arrange and order your objects. These
tools work for any object, and they can help you lay
out your pages quickly and precisely.

. Aligning
To align two or more objects:

1. Click and drag your mouse to form
a selection box around the
objects you want to align. All of
the objects will now have sizing
handles to show that they are
selected.

2. Click the Format tab, then
locate the Arrange group.

3. Click the Align drop-down
command.

4. Select one of the six alignment
options.
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@ % I} Bring Forward - E Group ﬂﬁ Find =~
& send Backward ~ [I"{ Ungroup | 2%, Replace

Wrap -

Text - S Rotate - | [ Select -

Editing

Align Left

Align Center
=| Align Right

gt Align Top

| Align Middle
it  Align Bottom

Distribute Horizontally
Distribute Vertically

‘_
Hla

&  Distribute Vertically
Eelative to Margin Guides

5. 'The objects will align to each other
based on the option you have
selected.

Another way to select multiple objects at once is
to simply hold down the shift key and click each
object you wish to select.

To align objects to the page, select Relative to Margin
Guides.

If you have arranged objects in a row or column,
you may want them to be an equal distance from
one another for a neater appearance. To distribute
objects select Distribute Horizontally or Distribute

Vertically.
= ) = > [l Bring Forward ~
" A Al EBE X
E Send Backward =
Styles Draw  Picture Table Shapes Wrap — -
- Text Box - - Teut = | |= Align ~
Fa | Styles Obje |=  Align Left range
o Il _n |2 : 1 . | & Align Center
=| Align Right
ot Align Top
F Align Middle
ol Align Bottom
Ml Distribute Horizontally '
@ Distribute Vertically
Relative to Margin Guides
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« Grouping
At times, you may want to group multiple objects
into one object so they will stay together if
they>re moved. This can be easier than selecting all
of the objects each time you want to move them.

To group objects:
1. Select the objects you wish to
group.
2. Click the Format tab, then
locate the Arrange group.
3. Click the Group command.

I}raWTng — —

Format
[ ; - 8
¢ 2=t @ % Lk Ering Forward % Group
[ Send Backward = II'] Un%]up

.Iqr W

Styles Draw Picture Table Shapes | Wrap

i

= + | Text Box - - Text= |2 Align ~ % Rotate -
w | Styles Objects Arrange
o B | Group (ctri+shiftG) I .
Join two or more selected objects
together so they will be treated as
one object.
e Press F1 for more help.

4. The selected objects will now be grouped. Backward command to
There will be a single box with change the objects ordering
sizing handles around the entire by one level. If the object
group to show that they>re one object. overlaps with more than one other

object, you may need to click the
You can ungroup grouped objects at any command several times to
time. Simply select the group, then click achieve the desired ordering.

the Ungroup command.

. Ordering objects
In addition to aligning and grouping objects,
Publisher gives you the ability to arrange
objects in a specific order. Ordering is
important when two or more objects overlap, as
it will determine which objects are in the front or
the back.
To change the ordering by one level:
1. Select the object you wish to move.
2. Click the Format tab, then
locate the Arrange group.
3. Click the Bring
Forward or Send
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Drawing Tools

Format = 1.
ﬁ Shape Fill = D |:|T |j e ['l Bring Fumaﬁﬂ* E Group
# Shape Outline - B | — ch @ <p & send Backw®d &1 Ungroup
Shadow 30 A Wrap L
¥ Change Shape = | Effects ~ o, Effeds = £ Text = T=Algn = "“h Rotate -
M | Shadow Effects 3-D Effects Arrange |

|l] , , ol , 1, Bring Forward

Bring the selected object forward
so that it is hidden by fewer
objects that are in front of it.

greenlight

® studios

The shape is
currently concealed
behind other objects.

Greenlight “:tud®s =
1706 Valhalla Bivd.
Seattle, WA 98102

4. Theobjectswill reorder themselves.

If you want to move an object behind or in front of € G Bring Forward - [#] Group
several objects, it’s usually faster to bring it to < T4 eh [L—[ﬁ Send Bﬁthﬂﬂld|*]IEI Ungroup
front or send it to back rather than clicking fal W @y SendBackward |5k Rotate -
the ordering commands multiple times. Effacts

1. Select the object you wish to move.
2. Click the Format tab, then
locate the Arrange group.
3. Click the Bring 5. Theobjectswill reorder themselves.
Forward or Send
Backward drop-down
command
4. From the drop-down menu,
select Bring to FrontorSend
to Back
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7.46  Working with Pictures To adjust brightness and contrast:
. . 1. Select the picture you wish to
+ Cropping pictures: adjust, then select the Picture
Pictures have additional features compared to other Tools Format tab and locate
objects i.e., shapes. They can be cropped the Adjust group.

2. Click the Brightness drop-

1. Select  the  picture, then down command.

click the Picture Tools 3. From the drop-down menu
Format tab and locate that appears, select the
the Crop group. desired  brightness.  Positive
2. Click the Crop command. numbers  (+)  will  make
3. The black cropping the picture brighter,
handles will appear. Click and while negative numbers
draga handle to crop the picture. (-) will make the picture darker.

The areas that will be cropped will
appear to be semi-transparent.

View F

Home Insert Page Design Mailings Review

- e ]| ﬁ O .ﬁCompressPldures Tk .
b i - “
0, ?;:E I Align ~ F{) Clear Croj - 5 Change Picture - — dl
+ € = Picture | |Brightness: Contrast Recolor ‘H S Swap «
- eset Picture
w Effects | Arrange Crop
9 Adjust | Swap |
: |3 |4 | |5 PR o 1 2 3
I|||I|||I|||I|||I|||I|||I|||I| |I|||I|||I|||I| b Ea] ||I|||I| " .|.|‘I.|.|.|.I.\.|.|.I.|.|‘|.I.|.|.|.I.|.|.|.I.|.|.|.I.|.‘.\

B Jm +30%
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o
9o
“" -20%
S
n
'K" -30%
]
o

a()=  40%

HAPPY HO

4. Click the Contrast drop-down

4. When you are satisfied with the command.
appearance of your picture, click 5. Select the desired contrastlevel.
the Crop command again. Positive humbers (+) will
5. The picture will be cropped. create a greater contrast

between the light and dark areas
. ) of the picture, while negative
+ Modifying Brightness and numbers (-) will reduce

contrast the contrast.
One of the most basic edits you can make to a picture

is modifying its brightness and contrast.

Although these tools are separated into two « To recolor the picture:

commands in Publisher, they are most effective 1. Select the picture you wish to

when used together. recolor, then select the Picture
Tools Format tab and locate
the Adjust group.
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2. Click the Recolor drop-down
command. S ) —
lilings Review View Format
. - : Wik |
3. From the drop-down menu _that ttures || ol = e
appears, select a recoloring o ' |
option or select More ! SWap —J

Variations to see additional . g
P
color choices. .

Haome Insert Page Design Mailings Review View Farmz

:| Z:i O . gCOmpressPid:ures ’;“j B -
Change Picture ~ -
| el -

‘H Reset Picture s

s, .  i\:iL_B
5 No Recolo F | Swap |

.|.|‘|.I.\.|l.|‘I.|.|.|.I.|.|2.|.I.|.|.|.I.|.|3.|.I.|
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i ]
E:g, Clear Picture Style

Light Variations

=
49 More Variations.., |E

7 SetTransparent Color

4. 'The style will be applied to the
picture.

. To add a caption:

4. The picture will be recolored. 1. Select  the  picture, then
. click the Picture Tools
- To apply a picture style: Format tab and locate
1. Se?lect the ) picture, then the Picture Styles group.
click the Picture Tools 2. Click the Caption drop-down
Format tab and locate command.
the Picture Styles group. 3. A drop-down list of caption

2. Click the More Picture styles will appear. Move your
Styles drop-d(?wn arrow: ) cursor over the caption styles to see
3. A drop-down list of styles will a live preview of the captions

appear. Move your cursor over the with your picture, then select the
styles to see a live preview of desired caption style

each style in your publication, then
select the desired style.
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— — (——— e
View Format Format Format

E’; Picture Bord

Review

g_/ Q #J :q?PidureShap

Swap

=

Simple - Layout1 |

4. Click the caption text box and
type your caption text.

« To restore a picture to its
original appearance:
1. Select the picture, then
click the Picture Tools
Format tab and locate
the Adjust group.
2. Click the
Picture command.

Reset

I Home Insert Page Design Mailings Review View

P ] :
Compress Pictures Wik

¥ O [gxe g ||

§ Py Change Picture = | ™ ‘

¢ | Brightness Contrast Recolor Swap |

- - - ‘E Reset Picture
Adjust h Swap
| |

Picture

ard all of the formatting
1ges you made to this picture,

ress F1 for more help.

3. 'The picture will be restored to its
original appearance.

Ifyou've worked with pictures in Word or PowerPoint
2010, you probably noticed that Publisher includes
only a fraction of the image editing tools featured
in those programs. If you find yourself reaching the
limit of Publisher’s editing capabilities, you may
wish to edit your picture in one of those programs,
then insert it back into your publication.

. Compressing pictures

You'll need to monitor the file size of publications
that include pictures, especially if you send them via
email. Large, high-resolution pictures can quickly
cause your publication to become too large, which
may make it difficult or impossible to attach to an
email. In addition, cropped areas of pictures
are saved with the publication by default, which
can add to the file size. Publisher can reduce the
file size by compressing pictures, lowering
their resolution, and deleting cropped
areas.

Only compress pictures after you have edited and
resized them. Attempting to enlarge or otherwise
edit a compressed picture may result in a blurry or
otherwise low-quality image.

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE
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To compress pictures:

1. Select a picture, then click
the Picture Tools
Format tab and locate
the Adjust group.

2. Click the Compress

Pictures command.

Home Insert Page Design

Mailings Review View

+ Brightness = Compress Pictures T
= z; g Jé 5 ST || mamm e 3
Contrast - B3 Change Picture - ‘ ’ ‘
Picture Swa
%Remlor' ‘EReset Picture . A \"/ —‘J
Insert Adjust | Swap | Picture Styl
complﬁsp-mrﬁ |||||||||h|||||||||||||||2||||||||||||||||3|||||||||||||||
Compress pictures in the document
to reduce its size. $
3 O 0
e
3. The . Compress 7.17  Inserting Tables
Pictures dialog box will
appeat. n Rev1evE the settings A table is a grid of cells arranged
13 ti the ) OxlpfrES?OH in rows and columns. Tables are useful for
PLions section. our boxes organizing information in a concise and easily
should be checked.

In the Target Output section,
select your planned method of
publication.

5. Choose whether to compress every
picture in the publication or the
selected picture only.

6. When you are satisfied with the

publication settings, click OK.

The picture or pictures will be

compressed.
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readable way. Text contained in tables is easy to space
and align, which make them ideal for presenting
lists of related information in Publisher, like store
hours or products and their prices.

In this lesson, you will learn how
to insert, modify, and change the appearance
of tables.

To insert a table:

1. Click the Insert tab, then locate
the Tables group.

2. Click the Table drop-down
command.

3. Hoveryourmouseover thediagram
squares to select the number
of columns and rows in the
table, then click your mouse.
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1 & |E B &

Page (Catalog Table Picture  Clip
~ Pages | = | Art

3x8& Table Iu

I [
I
| [
I [
I [
I [
I [

N

by
Insert Table...

4. The table will be inserted.

Depending on the size of the page you're
working with or t he other objects you
choose to add, you may have to resize or
rearrange your table.

Tables can be modified like any other
objects.

. Modifying table layout
To add a row or column:

1. Place the insertion point in a cell

2. adjacent to thelocation where
you wish to add a row or column.

3. Select the Table Tools
Layout tab, then locate the
Rows & Columns group.

4. Insert your new row or column.

o If you would like to
insert anew FOW, select
either Insert Above
or Insert Below.

o If you would like to
insert a new column,
select either Insert
Left or Insert
Right.

R U e | e G

Select | Wiew Delete  Insert ]nserll}x!nsert Insert Merge Split Diagonal

= Gridlines = Above Below ~ Left  Right Cells  Cells =
Table | Rows & Columns | Merge
Insert Rows Below
Add a new row directly below the . .
seleced v ; Specialties
Cakes
____________ R P RERCECERTRY FELEEES
EPumpkiﬂ. Spice |os24
iApple Spice i $24
____________ RO SR
EFudgz Chocolate : §22
____________ OO SN
EFudgz Marble : §22
____________ RO SRR
French Vanilla §22
____________ R R CERERCECERTRY FEREEES
| Strawberry Swirl 522
____________ ++
'Lemod] $22

5. The new row or column will
appear.

« To delete a row or column:

1. Select the row or column you wish
to delete by placing the insertion
point in any cell in that row or
column.

2. Select the Table Tools
Layout tab, then locate
the Rows & Columns group.

3. Click the Delete drop-down

command.
4. A drop-down menu  will
appear. Select Delete

Rows or Delete Columns.
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« Merging and splitting cells
If you want a create a cell that is wider or taller
than the other cells in your table, you can use
e B d H the Merge command to combine two or more

Home Insert Page Design Mailings

e THH B cells into one large cell.

Insert Insert Insert Insert @ I
Above Below Left Right {

To merge cells:
¥ Delete Columns LA ' 1. Select the cells you would like to

? Delete Rows merge.
8

[ Delete Table E} W 2. Click the Table Tools

Layout tab, then locate
the Merge group.

3. Click the Merge
Cells command.

Catering Speciali

5. The row or column will be deleted.

Home Insert Page Design Mailings Review

Design | Layout

] ] I =T 1] 11 7] 111
o R T & 0 (e EH=3 (|-
11 e i
N B o= “fili== i 1l
. = = =

Delete Insert Insert Insert Insert Merge | Split Diagonals Text
- Above Below Left Right | Cells  Cells - =l =l = pirection
Table | Rows & Columns I} Merge | Alignm

ELLES

Merge Cells

Merge the selected cells into one | I—
cell,

E Pumpkin Spice

4. 'The cells will be merged.
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You can separate merged cells by selecting them and -

clicking the Split Cells command. e
View Design Layout
- - ls E E E -
+ Modify cell text alignment: ] E = [Hﬁ' b%
1. Select the cells whose text you want ’ Text Hyphenation| Cell
to align. To select the entire table, s~ ==l 5 picedion z
click the gray box surrounding ' None i
= Top: a Bottom: O
the outer edge of the table. Left: 0O Right: 0
2. Click the Table Tools
Marrow
Layo_ut tab, then locate l%' Tope | 0.04° Bottom: 0.04
the Alignment group. - LIl | Left:  0.04" Right: 0.04"
3. Selectoneoftheninealignment in Sple
TONS Moderate
options. L. EI Top:  0.08" Bottom: 0.06"
pice | | L—H Left  Dw06" Right 006"
Zhooll | Wide
_____ i_ Top: 01" Bottom: 0.1°
=H e 01" Right 01"
Wan
Insert Page Design Mai-Fi-ngF_EﬂLm_. Wiew Desig Custom Margins...
E 3 merge Calls lb- a- : :
@ | % A | B split Cells i bC )
Delete | nse p. | F={ Diagonals - e 5. The new margins will be applied.
Rows & Columns | Merge Alignment
i . Apply a table style:
Align Center Right .
Center tert vertcally and sign it o 1. Click anywhere on the table,
enter tel
the right side of the cell, 5 then select the Table Tools
9 = Design tab and locate
' , the Table Formats group.
Cakes ; 2. Click the More Table
 Pumpkin Sgice Stylgs drop-down arrow to see
_______ R all available table styles.
| Apple Spice 3. Hover the mouse over the various
"""" P styles to see a live preview.

m” = ___TEE)TeTooI
File Home Insert Page Design Mailings Review View Design La
R
4. Your table text will be aligned. o | o Line Color~
- i Borders ~
- - f | Borders
5. Modify cell margins: [es
1. Select the cells you wish to
set margins for. To select the
. . FFFFEE EEEER FE=FE == === ===~
entire table, click the gray e S '
. P E FEFEE ShofE —ooo- Coooo 824
box surroundlng the outer edge SRR EEEER cese s coss D Eee=l|
EEFER] FEFER] S —--- - —=--=- 524
ofthetable. N e e e | S
. el ocooilcoooo lcoooa| | () =
2. Click the Table Tools e
Layout tab, then locate . ;22 ------
N HEEEE SEEES @-=-== 29---- #3-=--=- 1§ | [Aian—
the Alignment group. Sammm Hoooo 3000 coIIn Bt
. paEEE gs=sss 8---- 8---- 8---- . =
3. Click the Cell Margins drop- o oo x|,
down command. Effff E Tooo- B:_i:z_z ______
4. A drop-down list will appear. N R d $zz
Select the desired margins. 1

4. Select the desired style. The table
style will appear in the document.

ﬂ THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE



DIGITAL LITERACY

5. Add borders to a table:

1. Select the cells you wish to add
a border to. If you wish to add a
border to the entire table, click
the gray boxX surrounding the

outer edge of the table.
2. Click the Table Tools
Design tab, then Ilocate

the Borders group.

3. Click the Borders drop-down
command.

4. From the drop-down menu, select
the desired border.

I

zign Mailings Review View Design Layou
1% pt - ;
_# Line Color = =
= Wr
i Borders| Tex

Bottom Border Il

Top Border

'Left Border

Right Border

s+ Mo Border
Hﬂ All Borders

Pecan Outside Borders
______ Inside Baorders s
I'E-'Eld Inside Horizontal Border
Inside Vertical Border |
Late Chip Diagonal Borders
Brownie 316

5. 'The border will be applied.

6. Change the appearance
of borders:

1. Select the cells whose borders
you wish to modify, then click
the Table Tools Design tab
and locate the Borders group.

2. Click the Line Weight drop-
down arrow.

3. Select a new line weight from the
drop-down list.
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Table Tools

me

Insert Page Design Mailings Review View Design Layou

_____ = & 1% pt INE
::::: - Fill y‘pt

Y2 pt

|

Table Formats [F]

% pt

Cheesecake

1pt

s

2 Yspt

3 pt —

Butter Pecan $T4{ 43 pt e

6 pt —

Shortbread

4. Click the Line Color drop-
down command.

5. Select a new line color.

6. Double-
click the Borders command.

7. Changes to the border will be
applied.

« Add a cell fill color:

1. Select the cell or cells you wish
to add a fill color to, then click
the Table Tools Design tab

and locate the Table
Formats group.

2. Click the Fill drop-down
command.

3. Select the desired cell fill color.

FIanmngs nREVIEYY VICWY
— | Fil
‘Scheme Colors
| I HEE[] |
" I %I I I I |
= I I I d“
» | standard Colors
EE VT EER
zar]  NoFill
=2} More Fill Colors...
d Z  sample Fill Color
Pl B =

4. 'The fill color will be applied.
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7.48  Printing and Publishing
Before you print your publication,
take a moment to review the Publisher

printing options and settings. These
options give you the ability to control exactly how
your publication prints. If youd rather not print
your publication, Publisher also offers a way to
publish electronically.Print settings
Publisher offers a variety of print settings you can
modify to suit your needs. Among these are two
tools for advanced printing tasks: double-sided
printing and collating.

« Double-sided printing
Double-sided printing allows you to
print on both the front and back of each
sheet of paper. Publisher gives you two
choices for double-sided printing: You
can flip, or turn, the page on the long
side of the page or the short side.

If youre not sure how flipping the
page on each side affects your printed
publication, you can preview your
double-sided  printing  with  the
transparent view slider, which is

explained in the interactive below. You
can also print a page of your publication
and fold, staple, or otherwise prepare it
as planned. If the reverse side of your
page is upside down, choose the other
option.

Print One Sided .
Only print on cne side of the sheet
| Print One Sided

Only print on one side of the sheet

. Collating
The collated printing option
lets you assemble copies
of your publication with all
pages in the correct order.
By automatically grouping
individual copies of your
publication, collating can save
you a lot of time and effort.

Print on Both Sides [ |
Flip sheets on long edge

&

Print on Both Sides D}
Flip sheets on short edge

feti

LI=! FTINT 0N GOTA SI0Ees

Flip sheets on long edge

Collated
1 3 123 123 "

1,23 1,23 1,23

= 111 222 333 Kl

ge sign Mailings

1 ofl » [Front] Back 37% (=) (1

b save §
Print m o
L save as L@ =
Copies
& Save as Adobe PDF of print 1 ]
5] as Adobe ik jnhF:
& Open e
' Close Printer
Info HP Color Laserlet 2600 =
Ready
Recent Brinter Properties ok Zreghie
Settings
New
[ Print All Pages i
Pages: 1-2 p
Save & Send
J: One page per sheet -
Help —
. Letter -
3 oOptions 85x11"
4 eat [i=| Print.on Both Sides
S| Flip sheets on short edge
- Compesite RGB =
Print as RGE color publicati...
Save settings with publication
=l
4
4] i

—@E:IEEI
] »
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Before you print, review your print settings, and print
a final test copy of your publication. You should also
consider running the Design Checker. The
Design Checker is a tool that helps you find and
fix problems in your publication that may lead
to printing errors.
« ToruntheDesign Checker,go

to the Info tab in Backstage

viewandclickthe Run Design

Checker button. The Design

Checker pane will appear to

the right of your publication.

Design Checker
by
Run Design
Checker

[,

Use Design Checker to find potential problems in your publication before
printing, sending in e-mail, or saving with Pack and Go.

Design Checker v X

Click the listed
items to locate them
in your publication.

. Publishing electronically
Depending on the purpose of your publication, you
may decide to publish it electronically and
distribute it online. Publisher offers two ways to
do this. You can either:

« Publish as a PDF and attach the

file to an email or upload it to a
website

e Publish as HTML, which

Publisher then embeds directly
into an email

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE

Run general design checks
Run commerdial printing chedks
Fun web site checks

Run e-mail checks (current page
only)

nonprintable region
{Page 1)

Object partially off page
{Page 1)

Ohject is not visible
(Page 1)

Although Publisher promotes the HTML option
as useful, it is almost always better
to convert your publication into a
PDF. This is because the PDF option is better at
presenting your publication the way you designed it.
Publications saved as HTML can lose some of their
formatting and may not include custom fonts and
images.

However, PDFs aren’t perfect either. Depending
on the type of publication you're working with, the
PDF version may not be easy to browse and read.
For example, while you technically can convert a
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brochure to a PDF, the panels will not be lined up
as they would be in a printed and folded version.
If you're not sure whether or not your publication
is suitable for delivery as a PDEF, publish a test copy
early in the design process.

To publish as a PDF:

1. Navigate to Backstage
view, then select the Save &
Send tab.

2. Select Create PDF/XPS
Document, then click
the Create PDF/XPS button
in the right pane.

Home Insert Page Design Mailings Review View

HSH'H'E

Save & Send Create a PDF/XPS Document
B saveas S .
) ) Save this publication in a fixed format.
[ Open —1 SendUsing E-mail Publication looks the same on most computers
Ii.]-. Close Preserves fonts, formatting, and images
= E-mail Preview Content cannot be easily changed
Info — Free viewers are available on the Web
File Types
Recent | oo
ﬁ Change File Type
Mew
[
Print ‘ Create PDF/XPS Document
A=
Save & Send .
Publish HTML
Help
Pack and Go
B ootiens | T

3. The Publish as PDF or
XPS dialog box will open. Browse
for and select the location where
you wish to save your PDE then
type a name.

4. Click Publish.
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. |B] Publish as PDF or XPS

Organize - Mew folder

“ [esktop » mouse hole new menu - 4 Search mouse hole new menu
P +

= @

Microsoft Publisher Mame

‘i} Favorites

I Bl Desktop
ﬁ RecentPlaces

=) Libraries
@ Documents

Date modified Type Size

Mo itemns match your search.

J’ Music adll |

LI 2

File name: |[QETHSETEL]l0)]

Save as type: ’ PDF

Optimize for: | High quality printing |

[ Options... |

'~ Hide Folders

Open file after publishing

Tools [ Publish ] [ Cancel
L

5. Your PDF will be created and
opened. Make sure to double-
check for any mistakes before
sharing it.

7.19  Learning Activities

You have been asked by your employer to prepare a
professional document.

Required:

1. Create desktop publishing documents using
different designs, elements, layouts and
styles.

i. Add and rearrange pages
ii. Modify page layouts
iii. Insert objects and pictures
iv. Insert and format tables
2. Publish and print the document developed.

THE EAST AFRICA CUSTOMS AND FREIGHT FORWARDING PRACTICING CERTIFICATE

7.20 Self-Assessment Questions and
Activities

1. What is the role of desktop publishing
designs, elements, layouts and styles?

2. What are the critical factors to consider in
the preparation of professional document?
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8.0 COMPUTER NETWORKS, INTERNET AND
EMAILS

8.1  Specific Learning Outcomes

At the end of the topic, the trainee should be able to:
i. Identify Computer networks
ii. Describe Network configurations
iii. Describe the role of the internet
iv. Conduct searchers on the internet
v. Use emails for communication

8.2 Introduction

The topic introduces students to the concepts and
terminology associated with computer networks.
Issues related to networks are also discussed.
Students are exposed to networking devices and
applications. With the prominence of the Internet
in our personal and professional lives today, this
topic empowers students to appreciate how to use
the internet in facilitating business. The unit module
highlights how to conduct research on the internet
using different browsers and how to communicate
using different email platforms. Students learn how
officially communicate using emails.

8.3  Overview of Computer Networks

A computer network is a collection of computers and
other hardware devices connected so users can share
hardware, software, and data, and electronically
communicate.

Advantages of Networks

o Sharing of peripheral devices e.g. printers,
HDD, scanners, etc.

+ Sharing of programs and data

o Better communications e.g. e-mail.

Security of information

Disadvantages of Networks

o If the network stops operating, then it may
not be possible to access various resources

o Users work-throughput becomes dependent
upon network and the skill of the systems
manager

o Itisdifficult to make the system secure from
hackers, novices or industrial espionage

o Decisions on resource planning tend to
become centralized, for example, what
word processor is used, what printers are
bought, etc.

o Networks that have grown with little
thought can be inefficient in the long term.
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8.4 Types of Networks

e Wide Area Network (WAN): -
communications network that covers a
wide geographical area, such as a state or a
country.

San Francisco
San fazec

o Metropolitan Area Network (MAN):
- communication network covering a
geographic area the size of a city.

o Local Area Network (LAN): - privately
owned communication network that serves

users within a confined geographical area.

PCW i PC W i PC Wo Shared Databases
r ‘ ‘ | | ‘ ‘ | and Softwars Packages
‘ T T . T : r Natwork
Sarver

BB | B | =

[ [ [ =

| | |
‘ ' ‘ Shared Hard

L L L=
T T T T T T e

B | B | B | P

PC Workstation ~ PC Workstation  PC Workstation Wr

Internetwork Processor
1o Other Networks:

o Other Types
o Personal area network
o Storage area network
o Virtual private network
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Advantage: Smaller , Lighter,Faster
; (speed of light!)
— No interference
Disadvantage: Expensive Harder to
intemet VP install and modify

4. Wireless
. infrared, radio

_v J
Remote | roaming users \ .

SN
8.5  Computer Media “x‘/

Advantage: Flexible
o Communication Media provides Portable

communications channel between nodes Disadvantage:Slower data transfer than

hard-wired method
Subject to interference

o Hard Wired Methods
1. Twisted Pair Wire: - type of communication

channel consisting of two strands of . Microwave

insulated copper wire, twisted around each

other in pairs. Vo I\]\ﬁ
(L agl) )]
LR EA

Advantage: Easy to string ' .
Cheap Advantage: Speed of light

Disadvantage: Subject to interference Disadvantage:Line-of-sight only

= stati .
sHate . Satellite
2. Coaxial cables — This has a Single copper ;
conductor at the centre and a Plastic ' o

insulation layer. It is thus highly resistant
to interference

Advantage: Always in sight

Advantage: NOt susceptible to Disadvantage:Expensive uplink and
interference downlink facilities
Transmits faster

Disadvantage: Heavy & bulky Needs 8.6 Network Devices

booster over distance

This involves the hardware components associated
with networking namely:
« Network Interface Card (NIC): -

circuit board inserted into an expansion slot

3. Optic Fibre - Centre core made of glass or
plastic fibre
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in a microcomputer that enable it to send
and receive messages on a network.

o Switches: - Switches are an expansion of
hubs. They help connect different network
segments together. The diagram below
illustrates how switches and hubs work
together. Switches generally Keep track of
data packets

« Routers: = Connects any number of
different Networks. Using protocols, a
router can determine where packets should
go and figure out the best route to get
there. Without routers, the Internet
(which is essentially different
networks connected) could not
exist.

NB: Although bridges are still found in some
networks, bridges are no longer being installed
as new devices. Switches are replacing bridges
and hubs. Thus, a typical network will be made
up of switches and a router.

MIC

8.7 Network Terminologies

« Node: any device that is attached to a
network

o« IP Address - Number used for Node
identification

o Packet: fixed-length block of data for
transmission. It also contains instructions
about the destination of the packet.
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Switch

« Band Width - The amount of data that
can be transferred in a given period of time.
Defines Network Speed, measured in Kbps.

« Kilobits per second (kbps): unit of
measuring data transmission speeds

8.8 Network Configuration

Network configuration is the process of
assigning network settings, policies, flows, and
controls.

Network monitoring is a function of
network management that monitors a network
and alerts network administrators to potential
issues. The thresholds or conditions for alerting the
administrator can be configured based on network
traffic flow and business needs. When issues do
occur, networking configuration management
allows the administrator to quickly correct
the problem by modifying the configuration or
adding more network resources.

Other Metworks
Internet

Router

Configuration manager -  Network
configuration can also be automated and managed
via a centralized configuration manager network
configuration manager, further reducing manual IT
workload and making it easier to:

« Maintain a network

o Make configuration changes

« Relaunch devices

o Track and report data
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Benefits of Network Configuration
The right network configuration is essential to
supporting the flow of traffic through a network,
and it can also support and enhance network
security and improve network stability. Network
configuration tools can provide a number of benefits,
including:

o Automated data tracking and reporting,
allowing administrators to spot any
configuration changes and potential threats
or issues

o An easy way to make bulk changes, such
as a blanket password change in a situation
where passwords are compromised

o The means to swiftly roll back network
settings to a previous configuration

« Reduced downtime, thanks to increased
visibility and the ability to quickly identify
changes

o Streamlined maintenance and repair of
network devices (physical or virtual) and
connections

o The ability to relaunch a
device when it fails, thanks to
centralized storage management of device
configurations

Network Configuration Settings
When setting up a network switch and
router, its important to customize settings
and apply all necessary configurations to ensure
that your network will work properly. Some of
the configurable settings on a network switch and
router include:
« IP address—for identification
« Password—for added security
« Channel and band selection—to
improve performance
. Default gateway—to make the device
visible to network management tools
« Neighbour discovery—for added
visibility
« Correct time—for proper
troubleshooting and detailed error logs

8.9 Internet

o Internet: A matrix of networks that
connects computers around the world. The
Internet is any interconnection of computer
network, especially a global interconnection
of government, education, and business

computer networks, available to the public.

o Intranet: A network that connects computers
within a company or organization, perhaps
around the world. An Intranet is any
interconnection of a computer network,
that its access is limited to within that group
or organization and is not available to the
public.

o Extranet: A network based on Web
technologies that links selected resources
of a company’s intranet with its customers,
suppliers, or other business
partners. It is a community of interest
created by extending an intranet to selected
entities external to an organization.

Applications of the internet

o Browsing/surfing -  Searching  for
information. To searching the Internet, we
use Search engines such as Bing or Google
(www.google.com)

o Communicating - Using  Emalil,
Messaging (IM, Text), VoiP - Skype,
Video Conferencing/NetMeetings, Social

Networking
o Shopping - Ecommerce and Auctions
o Personal Finances - Such as Bill Pay,

Banking, and Investing
» Entertainment
o Cloud storage and SaaS

Internet Characteristics

«  Geographic Distribution - Global - reaches
around the world

o Robust Architecture - Adapts to damage
and error

o Speed - Data can travels at near ’ on copper,
fiber, airwaves

o Universal Access - Same functionality to

everyone

o Growth Rate - The fastest growing
technology ever

o Freedom of Speech - Promotes freedom of
speech

o The Digital Advantage - Is digital: can
correct errors

Authenticating a site
o Check for the Authors authority in the area
o Ensure the Title of the article is not biased
o Recent Date of publication or date of last
revision
o The URL should be the correct one
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Requirements for the internet

8.10

A web browser is the software (Internet
Explorer or Firefox or Google Chrome or
Opera or...) that accesses the Internet and
displays web pages, accesses e-mail accounts
& news groups and can be used to upload
files. It is your CLIENT software

A Web server is a computer that stores
the web documents that the users access.
Your Internet service provider should have a
web server on which you can “upload” your
web pages. The web server runs SERVER
software such as APACHE or Microsoft’s IIS
(Internet Information Server)

A web page is an Internet “document”
that can be accessed by Internet users with
an HTML browser. Web pages commonly
provide text, pictures, or other graphics,
and links to other pages.

Uniform Resource Locator (URL), -
a unique address that you must provide to
the browser to open a page on the internet.
It specifies a transmission protocol and
an Internet host (identified by a number).
It is used chiefly for moving around on
the World Wide Web Example http://
normandy.sandhills.cc.nc.us/cis172/menu.
html

E-Commerce

Commerce: the exchange of goods or
services

E-commerce: Act of doing business
transactions over the Internet or similar
technology

M-commerce: E-commerce carried out via
phones and other mobile devices

Advantages of E-Commerce

Reduced costs - Dotcoms are less expensive
than brick-and-mortar stores because there
is no physical storefront to maintain
Increased customer satisfaction - If
shopping experience is convenient (open all
the time, no driving, etc.)

Broader customer base (less geographical
restrictions)

Potentially higher sales

Convenience - Easier comparison shopping
Higher degree of selection

Potential cost savings

Customized products

Disadvantages of E-Commerce

Pressure to be always open, site always
working

Lost business due to some customer
hesitation to shop online

Risk of fraudulent credit card transactions
Ease of entry for competitors

Not being able to see or touch the goods
Possible expense of returning merchandise

E-Commerce Models

8.11

Business-to-consumer (B2C): An
e-commerce model in which a business
provides goods or services to consumers.
Wholesaler/manufacturer to end user
Business-to-business (B2B): Ane-commerce
model in which a business provides goods or
services to other businesses. Manufacturer
to wholesaler or wholesaler to retailer
Consumer-to-consumer (C2C): An
e-commerce model in which a consumer
provides goods or services to other
consumers. End users sell to end users
Business-to-government (B2G): An
e-commerce mode n which a business
provides goods and services to government
organizations

Electronic Mail (E-Mail) Concept

Email (electronic mail) is a way to send and
receive messages across the Internet.
It>s similar to traditional post office mail, but it is
electronic with digital content replacing paper
content and IP addresses replacing postal addresses.

Email advantages
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Productivity tools: Email is
usually packaged with a calendar, address
book, instant messaging, and more for
convenience and productivity.

Access to web services: If you want
to sign up for an account like Facebook or
order products from services like Amazon,
you will need an email address so you can
be safely identified and contacted.

Easy mail management: Email
service providers have tools that allow you
to file, label, prioritize, find, group, and filter
your emails for easy management. You can
even easily control spam, or junk email.
Privacy: Your email is delivered to your
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own personal and private account with
a password required to access and view
emails.

« Communication with multiple
people: You can send an email to multiple
people at once, giving you the option to
include as few as or as many people as you
want in a conversation.

.« Accessible anywhere at any
time: You don't have to be at home to
get your mail. You can access it from any
computer or mobile device that has an
Internet connection.

Email accounts
o To receive emails, you will need an email
account and an email address.
Also, if you want to send emails to other
people, you will need to obtain their email
addresses. It’s important to learn how to
write email addresses correctly because if
you do not enter them exactly right, your
emails will not be delivered or might be
delivered to the wrong person.
o Email addresses are always written
in a standard format that includes
a username, the @ (at) symbol, and
the email provider’'s domain.
o The username is the name you
choose to identify yourself.

Merced Flores {merced.flores73|@gmail.com>

tome |~
Hi Julia,

I'm ahenliitalv availahle ac a eriantificr ranaiiltant far

« The email provider is the website
that hosts your email account.

Merced Flores <merced.flores73@lgmail.com

tome [~

Hi Julia,

I'm ahenlhiitals availahla ac a eriantific ranainltant fary
o Some businesses and organizations use

email addresses with their own website
domain.

Email providers

. Free web-based email
service, also known as webmail
services exist. Anyone can use these
services.

« Today, the top three webmail providers
are Yahoo!, Microsofts Outlook.
com (previously Hotmail), and
Googles Gmail.

M Gmail
E/ Outlook

YAHOQ!

MAIL

Parts of the email
An email contains three parts: envelope, header, and
body.

« Envelope - An email is wrapped in
an envelope by the first Message Transfer
Agent (MTA). It contains the delivery
address, return address, and failed address
on the envelope. This information is used to
forward or deliver the email. An envelope
determines where the email will be delivered
or to whom it will be returned if it can’t be
delivered. The details of the Envelopes are
invisible to users but are visible to the email
applications (email clients).

. Header - The header keeps a record
of all information about the email such as
from which address it was sent, the date and
time when it was sent, by which MTA it was
received and forwarded, and when it was
delivered to the destination. Email client
programs usually hide headers from the
user while displaying the email contents.

« Body - The body contains the message
text and attachments. Originally, emails
were developed for text messages. Over
time, they started supporting several other
formatting techniques such as HTML
and encoding features using MIME
(Multipurpose Internet Mail Extensions)
features. allows us to format and encode the
email text with more advanced formatting
techniques such as HTML.

Types of email accounts

There are several different email account
technologies, and you should know which type you
have (or what kind you want, if you're still looking
for an email provider) because the setup and the
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choices of email programs you can use are different
for each:

Web-based: This type of email account
is designed to be used primarily with a
web-based interface. Many of the free email
services are this type, including Gmail,
Hotmail (now part of Outlook.com), and
Yahoo! Mail. This is the easiest, most no-
fuss type, and is great for casual users who
don’t send many messages and don’t want to
fool with setting up an email program.
POP3: This type of email account is
designed to be used with an email client,
although the provider may also allow web
access too. This type of account downloads
your received messages to your local PC
when it connects to the mail server. A POP3
account is tethered to a particular computer
where the received mail is stored; it’s best
for someone who uses the same computer
all or most of the time. POP3 stands for Post
Office Protocol version 3.

IMAP: This type of email account, like
POP3, is also designed to be use with an
email client. It does not download received
messages, though; it reads them from the
server, like web-based email does. That way,
you can browse your mailbox from multiple
computers and still see the full set of emails.
The downside is that you can’t browse your
mail if you aren’t connected to the Internet.
IMAP stands for Internet Mail Access
Protocol.

EAS: This type is similar to IMAP except it
is used by Exchange servers. It is a popular
type of account for groupware and corporate
accounts, as well as for mail delivered to
smart phones. EAS stands for Exchange
ActiveSync.

Email Etiquette

You should adopt courteous and polite habits when
writing your email messages.

Some of these are listed below.

Keep it Short - Reading text on the screen
is harder (and arguably) more hazardous
than reading on paper. Keep your emails
short, sweet and to the point and your
recipients will love you more.

Check Your Spelling - When you have
composed your message spend a bit more
time using the spell checker to check the
spelling. Then re-read the message and
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ensure that the spell checker has done its
job.

Use meaningful Subject Lines - Always
put meaningful text in the subject line of
a message, such as “Sales Figures for June’,
and so on. Many people use the subject to
prioritize reading or search for emails

Be polite - Flaming is the act of telling
somebody off using an email - and it should
NEVER be done. If you have a gripe with
someone, contact them over the phone or
face to face, but never through an email.
The big danger with email is that it can be
read over and over again. In email shouting
is done by using capital letters. Don’t use
capital letters (except in the proper literary
way for sentence starts, names, and the
like) unless you specifically mean to shout
something and be offensive.

Protect The Privacy of Others - If you are
sending a message to many people and it
is not necessary for the recipients to know
who else received the message, put their
addresses in the Bcc field and put your own
address in the To field - Outlook needs to
have at least one address in the To field.

Learning Activities

Identify a computer in your office or a laptop for use.

Required:

L.
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Undertake cable termination and router
configuration

Use different search techniques to search for
information on the internet related to your
training program.
Create email and
attachments.

send email with

Self-Assessment Questions and
Activities

What are the media communication
techniques that a firm in the freight and
logistics sector can use?

What is the importance of emails, internet
and e-commerce? How can a clearing and
forwarding firm use for improving business
performance?
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9.0 INFORMATION TECHNOLOGY SECURITY
9.1 Specific Learning Outcomes

At the end of the topic, the trainee should be able to:
i. Identify Security and privacy threats
(Information, Hardware, and Software)
ii. Preventing computer crimes
iii. Data Protection laws and copyright
issues
iv. Health concerns for computer users

9.2 Introduction

The increasing use of computers in our society
opens up new opportunities for threats such as data
loss due to system malfunctions or hardware theft,
software piracy, and digital counterfeiting. This
topic helps students appreciate computer-related
security and privacy concerns and identify solutions
to these concerns. Aspects of computer ethics and
etiquette are also examined. The topic concludes by
examining common health issues associated with
computers and ways of preventing them.

9.3  Overview of Information Technology
Security

There are a number of security concerns related to
computers that users should be aware of:
o Hardware - Losing the computer/device
entirely
o Software - Risks of acquiring pirated or
counterfeited products
o Data - Loss of Privacy
o User - Being watched

9.4 Hardware Security

o Hardware loss: Can occur when a personal
computer, USB flash drive, mobile device,
or other piece of hardware is stolen, lost, or
damaged

o Protecting Against Hardware calls for:

o The use of door and computer
equipment locks

o Use of computer tracking software:
Used to find a computer or other
hardware devices after it is lost or
stolen

o Proper hardware care by avoiding
misuse, using protective cases, Surge
suppressors, Uninterruptible power

supplies (UPSs), and maintaining a
clean environment.

9.5 Software Security

« Software piracy: Unauthorized copying of
a computer program. Protection Against
Software Piracy and Digital Counterfeiting
calls for:

o The use of Software antipiracy tools

o Educating businesses and consumers

o Enforcing Registration code or product
key

o Checking validity of a software
installation before upgrades or other
resources related to the program can be
used

o Malware - Malware, short for “malicious
software”, is any software designed to
infiltrate a computer system without the
owner’s knowledge. There are many kinds
of malware. Popular kinds include:

o Virus is a potentially damaging
computer program. Can spread and
damage files

o  Worm copies itself repeatedly, using up
resources and possibly shutting down
computer or network

«  Protection calls for the use of antivirus

9.6  Data Security

There are three core elements to data security that
all organizations should adhere to: Confidentiality,
Integrity, and Availability. These concepts are also
referred to as the CIA Triad, functioning as a
security model and framework for top-notch data
security.

. Confidentiality. Ensures that data is
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accessed only by authorized users with the
proper credentials.

Integrity. Ensure that all data stored
is reliable, accurate, and not subject to
unwarranted changes.

Availability. Ensures that data is readily
— and safely — accessible and available for
ongoing business needs.

Protection mechanisms include:

To ensure Confidentiality - Computers
add additional privacy challenges where
too much information is revealed though
surveillance, and Electronic Profiling
by Marketing database or Government
database. we need to safeguard against loss
of privacy. Be cautious of revealing personal
information. Supply only the required

Cybercrime is committed by
cybercriminals or hackers who want to make
money. Here are some specific examples of
the different types of cybercrime that can be
committed against a user:
o Email and internet fraud.
o Identity fraud (where personal
information is stolen and used).
o Theft of financial or card payment
data.
o Theft and sale of corporate data.
o Cyberextortion (demanding money
to prevent a threatened attack)
To protect the user, monitoring software
should be installed cautiously and proper
authentication mechanisms such as firewalls
put in place. The user should also safeguard
their passwords.

information in registration forms. Delete
your browsing history and e-mail settings 9.8
when using a public computer. Properly
dispose of hardware and outdated data.

Data Protection Law

Data Protection gives you some control over the
processing of your personal data. It imposes rules
upon data controllers and grants rights to data
subject. These rules apply to pretty much every
personal data processing operation; the rights can
be invoked by any living person.

Data protection is built around four rules:

1. There has to be a legitimate basis for the data
processing to take place;

2. The processing has to comply with the
principles of data protection;

3. The processing has to comply with certain
sectoral rules such as the prohibition on the
processing of sensitive personal data; and,

4. The rights of the subject, such as access and
objection, have to be respected.

o To ensure Integrity - Computers add
additional  privacy challenges where
information gets to the wrong hands
though hackers. Protecting the Integrity of
Personal Information calls for safeguarding
your e-mail address. Use a throw-away
e-mail address (an extra e-mail address that
you can use for activities that might result
in spam). 9-9

o To ensure availability is achieved - Have
backup and disaster recovery plans.

Health Concerns of Computer Use

o What are some health concerns of computer
users?

9.7 User Security

o Computer monitoring software can be used
to record an individual’s personal behavior
or computer usage either by capturing
images of the screen or recording the actual
keystrokes. Hackers (unauthorized users)
can capture usernames and passwords to
perform malicious acts to the user such as
commit fraud.
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—eye and vision
problems

—inflammation of nerve
that connects forearm to palm

Repetitive strain injury (RSI)

—inflammation of
tendon due to repeated motion
—when
compuier consumes entire
social life

o  Protection mechanisms include 9.10 Learning Activities
o Take frequent breaks during
computer session Arrange and plan an interview with the Manager,
o Use wrist rest Information Communication and Technology of a
o Exercise hands and arms firm in the freight and logistics sector.
o Adjust the lighting if possible
Required:
o Apply Ergonomics - Applied science 1. The ICT protection measures inherent in
devoted to comfort, efficiency, and safety the organization
in workplace. Ergonomics refers to 2. Strategies the organization uses to protects
minimizing injury or discomfort while its employees who use computers
using the computer. These include: 3. 'The laws related to ICT and data protection
o Position monitor correctly in your country and how the organization
o Use adjustable chair adheres to and implements the laws.
o Assume proper position while
typing 9.11  Self-Assessment Questions and
o Take breaks Activities

o Ensure adequate lighting

1. What are the different types of information
technology security threats?

2. What are the computer ethical issues and
ICT Laws in the EAC country where you
are located?

3. How should an individual protect
themselves from health effects of sustained
consumer use?
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